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Overview

This manual describes how to use the client software that is part of the iManage
DeskSite product. For information on the administrative utilities provided with
iManage DeskSite, plcase sce the iManage Server Administrative Manual. For
installation guidelines and instructions, see the iManage Implementation Guide.

The iManage DeskSite User Reference Manual is intended for end uscrs of iMan-
age DeskSite. It covers the functions and operation of the iManage DeskSite pro-
gram and the operation of Windows applications that are integrated with
iManage DeskSite. The manual also describes in detail the operation of the iMan-
age View and Portable programs.

How to Use this Manual

Users new to iManage DeskSite should read Chapters 1-5 to gain an understand-
ing of iManage DeskSite and how to use it. Users familiar with an earlier version
of iManage DeskSite can skim Chapters 1 and 2, then review the sections of
Chapters 3, 4 and 5 that describc new features or changes to the iManage
DeskSite program,

Chapters 6, 7, 8, and 9 describe special topics relevant to users of iManage
DeskSite. You should consult these chapters as their content becomes relevant to
your work,

Summary of Chapters

Chapter 1 provides an introduction to document management systems and iMan-
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age DeskSite.

Chapter 2 describes iManage DeskSite’s main program interface.

Chaprer 3 describes iManage DeskSite’s basic document management functions.
Chapter 4 describes how to perform searches in iManage DeskSite.

Chapter § describes how to use iManage DeskSite from within other Windows
applications.

Chapter 6 describes the advanced features of iManage DeskSite.
Chapter 7 describes how to use the iManage View program.
Chaprer 8 explains how to usc the iManage Portable program.

Chapter 9 explains how to use the document echoing option in iManage
DeskSite.

What is a DMS?

A document-management system (DMS) is software and/or hardware that man-
ages repositotics of millions of documents for hundreds or thousands of users.
Document-management systems can provide the following benefits to your orga-
nization: |

*  Easily manage online repositories that store millions of documents

*  Sophisticated tools for quickly finding documents without manually search-
ing file servers

*»  Consistent, system-wide document security

*  Ability to share documents with other users securely and easily
*  Creation and tracking of multiple versions of a document

*  Extensive document history and audit trails

*  Automatic archiving and restoration

Who Needs a DMS?

12

At organizations that do not use a document management system, file storage and
retrieval looks something like this:

*  The most common way to identify a document is through document names.
Despite efforts to enforce file naming conventions, document names still
tend to be arbitrary and often do not reflect the contents of documents.
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Hence, it is often difTicult to find necessary documents, once the file name
and directory have been forgotten,

*  Documents are scattered on the file server. A single file server may contain
thousands of directorics and tens of thousands of documents. For this same
reason, it is difficult to find and to share documents among users,

*  To create new versions of documents, users must rely on providing a differ-
ent name for the existing document. It is not possible to generate a report
describing when and which users revised a particular document, Applica-
tions do not keep track of document versions or who made changes to a par-
ticular document.

*  The ever increasing number of documents prevents users from locating
required documents. Staff members spend increasing amounts of time locat-
ing information, and documents have to be repeatedly generated because the
original versions cannot be located.

*  Document security is left to individual users, Unauthorized access is a com-
mon problem.

*  Itis difficult to determine which documents are ready for archiving or which
ones are in usc. Users do not delete old documents and thus end up wasting
nctwork resources.

*  Users cannot locate needed documents once they are archived to secondary
storage.

What Is iManage DeskSite?

iManage DeskSite is an enterprise-wide, mission-critical DMS. With iManage
DeskSite, you can greatly simplify the task of managing repositories of millions
of documents and making them available to thousands of users. iManage
DeskSite provides users with the following kinds of functions:

1. Search repositories of millions of documents

Search for documents based on document content

Sharc documents with other users

Search for and open documents from within major windows applications
Checkin and checkout documents

Create new versions of documents

P

Track document usage and history
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n Product Features

Document Profile Information

14

Each document in an iManage library has its own document profile record. The
information included in a document’s profile record can include;

the author

the operator who entered it into the library

the dale of creation

the version number

the user who last edited it

a lengthy description of the document

a short description of the document

comments

custom classifications used to identify, differentiate and group documents in

the library.

The information contained in a document’s profile record enables you to search
quickly for documents that you need without having to remember obscure file
names or where the documents are stored on the file server.

Table 1.1 lists the kinds of information that can be contained in the profile record

for a document,

Table 1.1: Document Profile Information Ficlds and Descriptions

Profile Field

Description

Number Unique number automatically assigned by iManage
DeskSite

Version Version number of the document (1—999)

Description Textual description of document, up to 254 characters

Name Short name of document, up to 16 characters

Type Document Type is usually bascd on the apphcatlon that

was used to create it
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Table 1.1: Document Profile Information Fields and Descriptions

Profile Field

Description

Author Author of the document has maximum security rights, and
is Novell Owner of the document

Operator Operator of the document has read/write access, and can
sct document access rights

Class General class of the document, defines default settings,
uscr defined

Client Client is a custom classification used to identify the docu-
ment,

Matter Matter is a custom subclassification used to identify docu-

ments, It is dependent on the entry for Client

Custom Fields

Captions of custom fields can be customized

Creation Date

Date document was created or installed

Last Edit Date Most recent date when document was edited

Last Edit Time | Most rccent time when document was edited

Last User Name of the user who most recently edited the document
Size Size of the document in number of bytes

Retain Days Number of days before inactive document is archived
Index Flag Marks whether the document should be full text indexed
Comment Comment associated with the document, up to 8,000 char-

acters, fully searchable

Note: The fields included in a document’s profile record can be customized
extensively, so some of the items listed here may not be included in your docu-
ments’ profile records, or different fields may be included that do not appear

here.

Document Security

Sharing your documents with other users becomes a secure and casy task with
iManage DeskSite, Each document in an iManage library has a custom sct of
security settings that determine who can access the document and to what degree
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they can access it.

To share your documents using iManage DeskSite, you select which uscrs should
have access to them and select to what degree they should have access to them.
Users can be granted read-only access, which allows them only to view the doc-
ument, or read-write access, which allows them to view and edit the document,
They can also be granted no access to the document, in which case they cannot
even locate the document in the library. You also specify a default security set-
ting for the document, which determines the level of access available to users not
specifically granted or denied access.

Pages

If Pages have been created using the iManage WorkSite application, you can scc
the Page hicrarchy in the folder tree, the integration dialog, and the browse for
folders dialog. You cannot create Pages in iManage DeskSite.

Folders

With iManage DeskSite, you can create groups of documents that are related
together and named as Folders. Folders can be made PRIVATE or PUBLIC,
depending on who needs to access them. When you create a folder, you can set
folder security to inherit security settings from the parent folder,

By grouping documents into folders, you can easily organize documents without
having to physically move them around or store them in the same placc. The list
of documents included in the folder can be displayed at once by clicking on the
folder icon for the folder.

Worklists

Each iManage server that you are logged into has a worklist icon associated with
it. By clicking on the Worklist icon, you can redisplay the forty documents that
you used most recently in the library. By clicking on your Worklist, you can
quickly access the documents you need and use the most. By default, documents
in the Worklist are sorted by the most recent date you accessed them,

Related Documents

In addition to grouping documents in Folders, you can create relations between
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documents to keep related materials together, such as a contract and an addenda,
For example, a contract could be related with the addenda to the contract or to
other documents used to create it.

You can create relationships between documents through an intuitive drag-and-
drop uscr interface. An icon in the iManage DeskSite desktop indicates docu-
ments that are related to other documents.

Saved Searches

iManage DeskSite provides powerful searching capabilities to help you find your
documents. You can scarch for documents according to document profile infor-
mation, the full text of document comments, or the full text of documents them-
sclves. After you perform a scarch, you can save your scarch results for later
immediate reference by clicking on the icon for the saved search. You can also
share your saved searches with other users by marking them PUBLIC.
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iIManage WorkSite’s Middle Tier Server

Clients and Servers

With iManage DeskSite, users access documents by logging into a machine
called a WorkSite Middle Tier Server, which in turn provides them with access
to documents stored in iManage librarics. The WorkSite Middle Tier Server
machine is called a “server” because it performs operations for other PCs. In this
casc, the WorkSite Middle Tier Server delivers documents to users’ PCs and per-
forms searches for documents across the network. PCs that are the recipients of
services from the server machinc are referred to as Client PCs. Client PCs have
iManage DeskSite’s user software installed on them, which enables them to con-
nect to the WorkSite Middle Tier Server,

By connecting to remote libraries through the WorkSite Middle Tier Server,
many users can access these libraries while minimizing the number of long-dis-
tance connections that need to be maintained between locations.

Documents

o
== '

User PC Middle Tier Server
(Client)

Ne—

J(

Documents

(

Figure 1.1: How a uscr accesses documents through iManage DeskSite,
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What is an iManage Library?

When we refer to an iManage Database, or Library, we are actually talking about
a library that includes three distinct entitics, Each iManage library is actually
composed of these three parts:

* afileserver, which stores the actual documents

+ aset of information tables, or database, that stores information about the
documents

* aselolindex collections of the [ull text of documents in the library, which is
uscd for searching

These three components — the fileserver, the information tables, and the full text
index — work together to organize and index your documents. From a user’s
standpoint, though, they opcratc as a single entity, or library, with a single name.

iManage DeskSite User Programs

There are three user programs provided with iManage DeskSite:

*  iManage DeskSite, which is the main interface between users and iManage
Librarics

* iManage View, which allows you to view multiple documents at once

« iManage Portable, which enables you to access documents while not con-
nected to the library
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CHAPTER 2

Using the DeskSite
Desktqp Window

Overview

The iManage DeskSite Desktop window is modeled on the Windows Explorer
and Outlook user interfaces and contains several display frames, menus and tool-
bars:

*  Shortcut frame: contains icons for shortcuts to important folders

*  Tree frame: organizes and displays information about servers, libraries,
folders and searches

*  Document grid: displays a document list that is either the result of search or
the contents of folders

*  Document Results frame: displays various information in tabular display
areas about a particular document

*  Menu Options and Toolbars: provide the functionality to perform every-
day tasks in iManage

*  Web Browser: provides access to the web directly from the iManage
DeskSite Desktop
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Figure 2.1: iManage DeskSite 5.0 Desktop Window

Shortcut Frame

The Shortcut frame contains shortcuts to frequently used folders. This provides
fast navigation to your most frequently used folders and scarches.

Two default shortcuts exist when you install the system:

*  Worklist shortcut: Performs a search for the last forty documents that you
uscd or edited.

*  Checkedout Documents shortcut: A list of the documents you currently
have checked out

To add a shortcut to the Shortcut frame:

Click the desired folder or saved search in the Tree frame and drag it to the Short-
cut frame. Then you only need to double-click the shortcut icon to display the
contents of the folder or search. This can eliminate significant folder navigation
time,

To add a document to your shortcuts:

Click the desired document in the Document Grid and drag it to the desired
folder in the Tree frame. The document appears in the Document Grid list when
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you click the icon in the Shortcut frame,

Shortcut Groups

You can organize the shortcuts you setup into Shortcut Groups, Clicking on the
Shortcut bar opens these groups. The top shortcut bar, named iManage, is a
dcfault group and cannot be removed.

To create a new Shortcut Group:

1. Right-mouse click the iManage shortcut bar

2. Sclect Add Group from the pop-up menu.

3. Typec the name of the new group in the space provided. Press Enter when
you are finished.

To remove a Shortcut Group:

Right-mouse click anywhere in the desired shortcut group and choose Remove
Group from the pop-up menu.

Tree Frame

The Tree frame contains the organizational structure of all servers, librarics,
iManage WorkSite pages if any, folders, worklists and saved secarches.

The iManage Desktop window’s Tree frame contains the following components:
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|5 Manage Databases

¢33 Checkedout Docs

~% Worklist

~ [ Search History

G- Corporate

| B Personal Pages

B2 Public Pages

~(3'] Bette's Page

~3'] BOWEN

5] Complete Test Page

5] New Page

5] Notification_Test

G1] Pam's Test Page

('] Release candidate
E]E‘]l Personal Folders

tl{3] Public Folders

@-{13 Private Saved Searches

- {1 Public Saved Searches(BOWEN)
B8 Public Saved Searches(Other)
E-[F sales

ESloer... | Hears | H3ocol.. [BYsoston |

Figure 2.2: Tree Frame

Servers

In iManage DeskSite 6.0 and later you can log into more than one scrver at a
time, Each connected server has its own Tree Frame of libraries, folders, scarch
histories and worklists. Click the server fabs at the bottom of the Tree Frame to
access each server,

Within the trec frame of cach server are the following four components:

e Checkedout Documents

Click on the Checkedout Documents icon to display a list of all documents cur-
rently checked out by the user. The documents appear in the Document Grid.

@ Worklist

The second icon in the tre¢ frame is the Worklist. This is a shorthand way of per-
forming a search for the forty documents you have most recently used or edited
on a particular server. The documents appear in the Document Grid.
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at+  Search History

The third icon in the Tree frame is the Search History. You can quickly re-run
scarches recently performed in iManage DeskSite by clicking on the appropriate

flashlight icon “2; displayed under the Search History branch of the tree frame.
The Scarch History icon only retains searches performed during the current ses-
sion. Clicking on a flashlight icon performs the search again using the same
scarch criteria originally entered.

@ Library

One library icon appears for each library available to you in a particular Server
tab. They may not all be visible at once in the Tree frame, so a vertical scroll bar
along the border of the frame on the right lets you bring additional libraries and
associated file folders into view.

Pages

If Pages were created in the iManage WorkSite application, you can see the page
structure in iManage DeskSite. You can access documents from folders on these
pages and perform all activitics on them that you can perform to documents in
other folders. The activitics you can perform depend on your Role and the access
rights you have to the Pages and Folders. You cannot create Pages in the iManage
DeskSite application.

Folders and Sub-folders

Libraries contain folders, which are static groups of documents you can create or
share with other uscrs. Folders provide a method for organizing and sharing doc-
uments easily. To display the contents of a folder, click the icon for that folder
and the documents within it appear in the Document Grid,

Creating a folder

To create a new folder, right click the icon for the library in which you want to
create a folder, To create a sub-folder, right click the folder icon. You must have
authority to create a sub-folder within that folder, The owner of the folder scts the
security upon creation and can grant security options to other users. See “Folder
securily” on page 26, You can create sub-folders under other users’ folders if you
are given authority to do so. Your iManage administrator can disable the ability
to create sub-folders under other users’ folders, The Create New Folder dialog
box appears requesting a folder name and folder description and naming the use-
rid of the folder owner,
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Create New Folder HE:

General | Secu[ityl

[} [NewFolde

Description: _:l

Owner: BOWEN

oK Cancel

Figure 2.3: Create New Folder dialog -- General tab

Folder security

When you create a sub-[older, it has the same security settings as the parent
folder by default. You can change these settings if you wish by deselecting the
Inherit permissions from parent checkbox. If your role does not allow you to
create public folders, you cannot access the security tab,
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Create New Folder K
General Security I
¥ Inhetit permissions fom parent
Default Security: |F'rivate EI
Permission Entries:
I | Name [ Alow L. | Access Highlsl
€ BOWEN Bette OwenKelley v Full Access
Type of Access: IFuli Acoess j
Add User,.. | #dd Group... Rennove |
ok Cancsl

Figure 2.4: Create New Folder dialog -- Security tab

*  1lyouselect Private as your default security sctting on the folder, then only
you and other users or groups to whom you specifically grant access to the
folder can see it.

* Ifyou sclect Public, then all users, except those specifically denicd access,
can add documents to the folder or remove documents from the list of those
contained in the Folder,

* Ifyou select View, then all users, except those to whom you specifically
grant Modify or No Access, can view the folders contents, but cannot add or
remove documents from the folder, (i.e., view access restricts uscrs from
changing the list of documents that constitute the contents of the folder).
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Create New Folder [ 7]

General Security |

I Inherit permissions from parent

Default Security: IView R4

Pertmission Entries:
(D [ Name | AllowL... | Access Righ!s|
£ PVINCENT PamelaVincert Y ReadMiite
€ JTAMBURELLO  Joe Tamburelo Y No Access
€ BOWEN Bette OwenKeley Y Full Access
€ APHILIPS Anthony Phiips Y ReadMwiite

Type of Access: (IR NN - |

Add User... | Add Group... | Remove |

OK Cancel

Figure 2.5: Create New Folder dialog -- Security tab -- Permissions not inherited
from parent folder

You can also specify greater or lesser access privileges for specific users and
groups by making a sclction from the Type of Access drop down list. The access
privilcges that you grant to specific users and groups using the Type of Access
drop down list are EXCEPTIONS to the general security settings you selected for
this folder.

*  No Access--Cannot sce the folder.

*  Full Access--Can set sccurity on the folder, add or remove items from the
folder, create subfolders, and delete the folder.

*  Read--Can view documents in folder, but cannot add or remove them.

*  Read/Write--Can add or remove documents {rom the folder and create sub-
folders, but cannot change folder security.
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Note: The sccurity scttings on a folder only detcrmine two things: (1) whether or
not a user can sec the folder; and (2) whether or not the user can add or remove
documents from the folder. Whether or not a user can EDIT a document or only
vicw it is determined by the security settings for the document, not those set on
the folder. Depending on the access privileges sct on the documents contained in
a [older, a particular user may or may not see any documents contained in the
folder, may have read-only access to the documents, yet be able to add docu-
ments to the folder, or may be able to edit documents contained in the Folder, but
cannot add documents to the folder. For more information on document-level
sceurily, see “Setting Access Privileges” on page

Deleting a folder

To delete a folder that you created or have Full Access to, click the folder so that
the folder name is highlighted, then press the Delete key. A Confirm Delete dia-
log box appears, asking you to confirm that you wish to delete the folder. Click
on OK to delete the folder.

Note: Dcleting a folder does not delete its contents, only the folder.

Adding Documents to a Folder

You can add documents to a foldcr that you created, or have Full Access or Read/
Write access to. Use drag-and-drop technique to add documents already in the
library:

1. Inthe Document Grid, highlight the document you want to add.

2. Click again on the document row, keeping the left mouse button depressed.
The pointer becomes a document icon.

3. With the left mouse button depressed, move the pointer to the right of the
appropriate folder icon in the Tree frame,

4. Release the mouse button. The document is added to the folder that you
selected.

Importing Documents to 2 Folder

1. Highlight the folder where you want to import a document.

2. Sclect Import from the File menu.
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Navigate to the document you want to import and highlight it.
Click Open,

Complete the New Document Profile dialog.

Click OK.

S S

Editing the Properties of a Folder

Once you create a folder, you can edit its properties — name, description, and
security (i.c., whether it should be public or private). You can also edit folders
created by others if you have been granted Full Access to those folders.To edit
the attributes of the folder, right-click on the folder icon and select Properties
from the popup menu. Only the owner of a folder or a user to whom the owner
has granted Full Access can edit properties.

To change only the name of the folder, highlight the folder and press F2. Enter
the new folder name and press Enter.,

Saved Searches

A library may have saved search icons {Jg that contain search criteria that have
been saved for later use. Saving scarches allows you to perform routine searches
of the library without having to reenter common search criteria, Clickingon a
scarch icon causes the search to be performed again. The documents found dur-
ing the search are displayed in the Document Grid. Sce Chapter 4 for specific
instruction on creating a Saved Scarch.

Deleting a Saved Search

You can delete 2 Saved Scarch that you created in much the same way as you
delete a folder that you created. Click on the icon for the Saved Scarch, then
press the Delete key. Deleting the Saved Search does not delete the documents
displayed in the search; it only delctes the search profile from the tree frame.

Opening and Closing Nodes in the Tree Frame

Nodes are the plus and minus symbols appearing throughout the tree structure
wherever there is a branch. Clicking the minus symbol changes it to a plus and
vice versa, When a minus sign appears in the node, you can sce the tree structure
beneath the icon to the right of the node; when a plus sign appears in the node,
the tree structure is collapsed and you cannot see it. You can sce the entire tree
structure when all nodes are minuses,
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Note: The sccurity scttings on a folder only determine two things: (1) whether or
not a user can sce the folder; and (2) whether or not the user can add or remove
documents from the folder. Whether or not a uscr can EDIT a document or only
view it is determined by the security settings for the document, not those set on
the folder. Depending on the access privileges set on the documents contained in
a folder, any given user may or may not see any documents contained in the
folder, may have read-only access to the documents, yet be able to add docu-
ments to the folder, or may be able to edit documents contained in the Folder, but
cannot add documents to the folder, For more information on document-level
security, see “Sculing Access Privileges” on page 53,

Navigating in the Tree Frame without a Mouse
*  Up and Down arrow keys move cursor in up and down in tree
+  Left and Right arrow keys function to open and closc nodcs in the tree
* Enter sclects a Worklist, Folder, or Saved Search, as if you clicked on it,

Note: When you select a Worklist, Folder or Saved Scarch, focus automatically
shifts to the Document Grid, cnabling you to use keyboard shortcuts to navigate
in that frame as well.

Document Grid

The Document Grid displays the results of an iManage DeskSite search, worklist
or the contents of a folder.

'Y Doc. Num| Ver... Edit Date v
Eii 1,015,054 1 JJACOB 02/26/2000 11:06:06 A
@' Telephone List 1,012,858 1 BOAEN DOC 0212472000 12:15:50 PM
EE Document2 1,000,247 3 BARBARA DOC 01/27/2000 6:27:42 PM
@' Documenrt 51,265 2 DIPALI PUBLIC 120091939 4:03:01 PM -
' i ACCAOD4J 1,013,536 1 WLl DOC 12/08M1993 6:15:20 PM
Document2 60,072 1 DCHAN PUBLIC 10114999 11:57:.20 ANV
@ document1 52,098 1 DCHAN PUBLIC 09/01/1999 5:12:32 PM ¢
T?:’i l:iv bmemd L AAPA A Sl e TARTA A BRUIARL L RAS _.-n-rnnunnn 47-'..—\-_1.—_\-\1'L|

Figure 2.6: The Document Grid
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Sorting Documents in the Grid

To sort the contents of the Document Grid by any column, just click the desired
column heading. To sort in reverse order—that is, from ascending order to
descending or vice versa—click the heading again.

@ Document column

The left most column in the Document Grid is the document icon column which
displays an icon representing the document type. You cannot remove this column
from the document grid.

Status column

This column displays icons to indicate the current status of the document. You
cannot remove the status column from the document grid. The icons that may
appear in this column are:

B  The document is archived.

&  The document is checked out.

@  The document is locked.

B  The document has other documents related to it.

Selecting Documents

Clicking on a document in the Document Grid highlights the document in blue.
You can select multiple documents by keeping the Ctrl key depressed and left-
clicking the desired documents. You can select a range by depressing the Shift
key and thea left click on two documents in the grid; those two documents and all
those in between are selected. If you are unable to usc the keyboard and mouse
simultaneously, we recommend enabling Sticky Keys, which is available in Win-
dows 98 and 2000 and Windows NT. Enablc Sticky Keys from the Accessibility
Options Control Panel which comes installed with your Windows 98 and 2000
and Windows NT operating system.

Performing Actions on Documents

With iManage DeskSite you can perform a variety of actions on the documents
listed in the document grid. Execute these actions by:
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»  Highlighting the desired document(s} and clicking an icon in the toolbar
icons at the top of the Desktop Window. (See *“Mcnu Options and Toolbars™
on page 38 for more information on the toolbar)

* Highlighting the desired document(s) and selecting an option from the Doc-
ument menu (see Eigure 2.6).

*  Accessing the document menu with a right-mouse click on the desired docu-
ment.

Customizing the Document Grid and Profile

You can configure the Document Grid in several ways so that it displays the
information you want in the format you want. You can customize the Display
Columns and the Profile Ficlds that appear in the Document Grid,

To Customize what columns appear:

1. To do this sclect Options from the Options menu. This launches the Con-
Jigure dialog box (sce Figure 2,7).

AUT0020033



iManage DeskSite User Reference Manual

34

‘ Configure | X |
Select Profile Fields | Defaults I Configure |

Available Profile Fields: Display Column Fields:
Archived Add > Database
Authot Desctiption
Author Description <- Remave || Doc. Num
Checked Out Version
Class o Authar
Class Description Class
Comments Edit Date
Create Date File Size
Custom?
Custom1 Description
Custom10
Custom10 Description
Custom11 o
Custom11 Description Profile Fields:;
Custom12 —
Custom]% Description Add > ggzcrr:ﬂt:;n
Custom . i
Custom14 ¢ Rerove \Tfersmn

¥ype
Custom15 Class
Customlb Custom]
Custom17 Custom?
Custom18
Custom1S Comments
Custom?
Custom? Description
Customad

Drag for Order
oK | Cancel Help

Figure 2.7: Configure dialog, Select Profile Fields tab

2. Choose the Select Profile Fields tab.

3. Add ficlds you want to scc as column headcrs in the Document Grid from
the Available Fields list to the Display Column Fields or the Profile Fields

list,

Remove fields you do not want to sec as column headers in the document

grid from the Display Column Fields or the Profile Fields list to the Avail-

able Fields list.
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Note: Thc Profile Fields list in the lower right corner of this dialog dctermines
which profile fields display in the Document Profile tab of the Document Results
Frame in the lower-right portion of the main desktop window.,

5. Click OK when finished.

Customize Display Options Defaults:

Sclect Options from the Options menu. This launches the Display Options
dialog (sec Eigure 2.8). Then choose the Defaults tab. There are two features to
customize in the Document Grid:

i
Configure El;

Select Profile Fields  Defaults | Corfigure |

Search

Change search result options.
% Maximum number of documents in Sea:ch Window:

o

’— Document Yersion

¥ LatestVersion Only € All Versions

Figure 2.8: The top portion of the Display Options dialog, Defaults tab.

+  Select the maximum number of searches to appear in the Document Grid.
This will prevent an overwhelmingly large search return impacting the per-
formance of your system,

*  Select whether you want the Document Grid to contain only the latest ver-
sion of each document or show all versions.

Navigating in the Document Grid without a Mouse

Up and Down arrow keys move the cursor up and down in the grid. The Page Up
and Page Down keys also move the grid up or down.

Document Results Frame

The Document Results frame provides information about a particular document.
There are five tabs:
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[\Document Profile £ QuickView A _Related Documertts A__Document Versions A History /

Figure 2.9: The Document Results Frame tabs

Switching Tabs in the Bottom Pane of the Document Grid
Ctrl+Tab switches from tab to tab in the bottom pane of the Document Grid.

Document Profile Tab

You can vicw a document’s profile by highlighting & document in the Document
Grid and then clicking the Document Profile tab. You may not edit any of the
ficlds appearing in this tab. To edit profile ficlds you must launch the Edit Profile
dialog.

Which profile ficlds appcar in this tab is determined by the scttings of the Profile
Ficlds list on the Select Profile Fields tab in the Configure dialog, launched from
the Options menu.

Quickview Tab

To view a document without leaving the iManage Desktop, highlight the docu-
ment and click the Quickview tab. You can also right-click the desired document

and sclect Quickview from the pop-up menu or click the Quickview icon [
from the toolbar, A read only image of the document appears in the Quickview
tab.

Related Documents Tab

To see a list of a document’s relations, highlight the document and click the
Related Documents tab. You can also right-click the desired document and select

Related Documents f{rom the pop-up menu or click the Related icon ",—"“Tf from
the toolbar. A list of the document’s relations appears in the Related Documents
tab,

Document Versions Tab

To sce a list of 2 document’s versions, highlight the document and click the Doc-
ument Versions tab. You can also right-click the desired document and select

Versions from the pop-up menu or click the Version icon @ from the toolbar. A
list of document’s versions appears in the Document Versions tab.
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History Tab

To see a list showing events in the document’s history, highlight the document
and click the History tab. You can also right-click the desired document and

sclect History from the pop-up menu or click the Version icon @J from the tool-
bar. A list of activities performed on the document appears in the Document His-
tory tab. The history tab shows such activities as Create, Checkout, Open,
Checkin, Print, Modify, Location of the activity and comments about certain
activities.

Document Results Frame PushPin

The PushPin allows you to control the relationship between the Document Grid
Frame and the Document Results Frame, Depending on the PushPin state, the
Document Results Frame behaves differently when you click on an item in the
Document Grid Frame, You can sct the PushPin scparatcly for cach tab in the
Document Results Frame, Your iManage Administrator can sct the default state
and disable certain states.

PushPin State Tab Name Tab Behavior
! Up All tabs Goes blank
mal
Down All tabs Automatically
!‘i @ refreshes
Locked Related Documents | Stays the same as

-

before you ¢licked
on another item
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Menu Options and Toolbars

The following table shows the keyboard shortcuts and toolbar buttons for fre-

quently used functions in iManage DeskSite. Menus are customizable by your

system administrator, so some options may not appear or may have different
namcs.

Table 2.1: iManage Toolbar

Menu Option Keyboard Shortcut | Toolbar Icon
Search Ctrl+F I&J

Refresh | o
Print Document List -- E &

Print Preview - 3

Open Ctrl+0 =

Edit Profile Ctrl+E zl
Verslons Ctrl+S T@J
Quickview Ctrl+Q A

View - &

History Ctrl+H @J

Related Docs Ctrl+R

Checkout - {

Checkin —

Send Document URL -

Unlock ——

2 [® | ]| & | &
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Table 2.1: iManage Toolbar

Menu Option Keyboard Shortcut | Toolbar Icon
Remove from Folder --- @ E
Import .- Cn
Export - [B ‘
Purge - 2
Synchronize Echoed --- oo
Documents '
Set New Document

Default
Setup Local Applica- -
tions Table
Security Template - )
Set Security on Multiple | --- =
Documents

Change Password - =
Send Document - =
Send Link - 2
Copy Document ---
Copy and Open Docu- - B
ment

Create New Version - 5
Create New Version and | --- ™
Open

Print Selected Document | --- =
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Table 2.1: iManage Toolbar

Menu Option Keyboard Shortcut | Toolbar Icon
Checked Qut Informa- -
tion A

Customizing Toolbars

iManage DeskSite allows users to both edit the default toolbar and customize
new toolbars.

Sclect Customize Toolbar from the Options menu or right-mouse click on
the toolbar you wish to customize and select Customize... from the pop-up
menu, The Customize dialog will launch displaying a Toolbars tab and a Com-
mands tab.

In the Toolbars tab of the Customize dialog you can:

*  Activate or deactivate the toolbar on your desktop by highlighting the tool-
bar in the list and checking or unchecking the checkbox.

*  Create a new toolbar by clicking on the New button, You are asked to give
the toolbar a name,

*  Delete a customized toolbar by highlighting the desired toolbar and clicking
the Delete button. (You cannot delete the iManage toolbar)

*  Resct the iManage toolbar back to its original state by highlighting it and
clicking the Reset button.

*  Activate the tool tips checkbox which will popup the button name when the
mouse pointer hovers over a button,

*  Activate the 'cool look' checkbox to display buttons in a different way.

In the Commands tab of the Customize dialog you can:

Select from various toolbar categories. iManage DeskSite has one default cate-
gory called iManage. Your system may have others, When a category is high-
lighted, the available butlons appear to the right of the Categories list,

Build a toolbar by dragging and dropping button commands from this Com-
mands tab to the desired toolbar on your desktop. Remove a button from the tool-
bar by dragging and dropping the button from the toolbar back to the Commands
tab.
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Web Browser

iManage DeskSite has a web browser utility to allow you to quickly access the
web directly from the iManage Desktop. When launched, the browser takes over
the space occupied by the Document Grid and Document Results Frame. To pro-
vide morc web-browsing space, de-sclect Shortcut Bar option in the Options
menu, You can also use standard mouse-based Windows re-sizing techniques to
create a larger browsing space.

Web Browser Toolbar

Address Field: |Address |@ hitp: //www.imanage.com/ |_'_|

Typc in a standard web address, or sclect from a previously sclected address by
using the drop-down arrow, and the site launches.

FERN

Arrow Commands:

These commands help you navigate backwards and forwards. The forward button
will only be available if you have navigated backward at some point during the
current browsing session,

Reload Command:

This will refresh the currently loaded page and include any changes since the last
time you loaded the page.

Stop Command:

If 2 page you are trying to load is taking too long to display, you can cancel it by
clicking the Step icon on the toolbar.

Home Command: ﬁ

Your browser’s home page is the page that first appears when you launch the web
browser. You can return to this page at any time by clicking on this Home icon.

To change your home page in Microsoft Explorer launch the MS-Explorer appli-
cation and select Internet Options from the View menu. Type in your home
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page address in the space provided in the General tab.

Search Command: @

This command will launch the Microsoft scarch engine at Microsoft’s main web
site,

. 1 -
Favorites Menu: [:j

The favorites menu contains standard Explorer functionality to add and organize
favorite web sites that you visit repeatedly.
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CHAPTER 3

IManage DeskSrte’
Basic Functions

Overview

This chapter describes the basic document management functions available in

iManage DeskSite, These include:

+  Connecting to WorkSite Middle Tier Servers
+  Opcning documents

*  Viewing documents

»  Searching for documents

*  Checking out documents

+  Checking in documents

*  Relating documents to one another

*  Working with multiple versions of documents
+  Copying documents

+  Sending documents and document attachments
* Importing documents

*  Exporting documents

»  Entering and Editing Profile Information

*  Setting Access Privileges on a document

*  Viewing document history

*  Unlocking documents

*  Decleting documents

*  Restoring Archived Documents

+  Changing passwords
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Note: For information on more advanced functions, sce Chapter 6, 7 and 8 in
this manual. For information on using iManage DeskSite from within an inte-
grated application, sce Chapter 5. The iManage Integrated Desktop window,
which is available by sclecting Open from the File menu in integrated applica-
tions, is described in detail in Chapter 5.

Connecting to WorkSite Middle Tier Servers

Your first stcp in using iManage DeskSite is to register any WorkSite Middle Ticr
Servers you wish to connect to. The WorkSite Middle Tier Server is how you
gain access to your documents and databases. To register and log into a WorkSite
Middle Tier Server, you need a valid Login, Password and Server name:

1. Select Register/UnRegister from the Login menu. This launches the
Register Servers dialog,

Register Servers X

~ Register Server
Enter Server Name: [CHICMSIMANAG v] Register |

—Registered Servers
CIE3BOSTON

[ EB CHICMS.IMANAGE.COM
O£ PaRIS

Unregister | | Disconnect Clase | Help

Figure 3.1: Register Servers dialog. The icons show which servers are con-
nected. In this illustration, BOSTON and CHICMS.IMANAGE.COM are con-
nected and PARIS is not,

The dialog shows a list of all the servers that are registered. A check in the
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checkbox indicates that the server is set to log on automatically when you
open iManage DeskSite. You can select which registered servers to log into
by checking or unchecking them.

To disconnect from a scrver to which you are currently connected, highlight
it and click Disconnect. You will not lose the login information you have
already entered for that server,

To reconnect to a server to which you are not currently connected, highlight
it and click Reconnect.

To change login information for a server, highlight it and click Unregister.
Then register the server again.

2. Enter the name for the WorkSite Middle Ticr Server or the Server Cluster in
the Enter Server Name: ficld and click Register. This launches the scrver
Login dialog.

e ~ |
Server Name: IEL»&CKB 0 M

- 1 Login Information
! ¥ Auto Login
I Use Trusted Legin

UserlD: IUSEHID

Passward: I"“”’1

Login Cancel | Help

Figure 3.2: Login dialog

Note: Your servers may be set up in a server cluster arrangement that includes
multiple servers scrving the same iManage librarics. The multiple scrvers pro-
vide additional fault tolerance in the event of a server failure and enhanced per-
formance. You log into a cluster the same way you log into an individual server.

3. Enter your uscrlD and password in the UserID and Password ficlds.
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Note: For sccurity reasons, you must cnter your UserID and Password correctly
in a limited number of attempts. Your iManage administrator sets the number of
attcmpts you can make before the system locks you out. If this happens, contact
your iManage administrator to reset your password.

4. If you want to log into this server automatically when you open iManage
DeskSite, cheke Auto Login,

5. If Trusted Login is enabled by your Administrator and you want to use this
feature, check Use Trusted Login. When you check this box UserID and
Password are blanked out.

6. Thenclick Login. If you have entered authentic login information the Server
appears in the list box of the Register Servers dialog,

Note: You can repeat these steps for as many Servers as you would like to Reg-
ister for current or future use. From the Register Servers dialog you can connect
to or disconnect from any of the registered servers. At the startup of the iManage
application, only connected severs are automatically logged on.

Trusted Login Option

The Login dialog box also presents you with the eption of using your network
login ID to log into the WorkSite Middle Tier Server. To use this option, check
the Use Trusted Login checkbox. The User and Password entry boxes arc
locked out if you check this box.

Note: Your administrator must specifically enable this option. If you try to use
this option and reccive an error message, try logging in without using the Trusted
Login option.

Connecting to an Additional WorkSite Middle Tier Server

To connect to a different WorkSite Middle Ticr Server, open the Register/UnReg-
ister Servers dialog and select from the available registered servers (or register a
new one) and click Connect. Click OK to complete the login. You can connect to
several WorkSite Middle Tier servers at once.
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Auto Login on One or More WorkSite Middle Tier Servers

Once you have registered the WorkSite Middle Tier servers you nced, you can
select which ones you want to log into automatically when you launch iManage
DeskSite. To select Auto Login servers, check the box next to the server name.,
To desclect a server uncheck the box. Deselecting a server does not unregister

that server, Sec Figure 3.1,

Unregistering a Server

To unregister a WorkSite Middle Tier Server without exiting iManage DeskSite
manuzlly, open the Register/UnRegister dialog, highlight the desired server and
click the Unregister button. Click Yes to confirm the unregister request.

Logging Out

You are automatically logged out of the WorkSite Middle Tier Server when you
cxit or closc iManage DeskSite,

Autosynchronize/Checkin Alert

If you have edited any portable or echo documents since the last time you ran
iManage DeskSite, the following alert message appears immediatcly when you
open iManage DeskSite. This message indicates that there arc portable or echo
documents stored on your [ocal drive that have been changed. To synchronize
these documents back to the database or check them in, click the Yes button in
the message box shown below, You have the option of copying them back as the
original document, importing them as new versions of the original document, or
importing them as new documents. I you click No and do not synchronize or
check in the documents in question, this message box appears again the next time
you launch iManage.

iManage

Documents in your echo directory have been mm%ed
Do you want ko synchronize your documents with the network ?

Yes No |

Figure 3.3: The Autosynchronize or checkin alert box appears to inform you that
you have portable or echo documents stored locally that need to be synchronized
back to the library.
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If you select Yes in the autosynchronize/checkin message box, then a dialog box
appears that allows you to check in any portable documents that you have
checked out or synchronize any echo documents that you edited. This dialog box

is shown in Figure 3.4

If you want to show only documents that have changed, check the Show only

echo modified checkbox.

Checkin/Synchronize Documents

Checkedout Documents  Echo Documents |

Session Name: |p,q}:;|5 ~]
_f__l Database | Descripticn | Doc. Num| Version| Type Synch...
Marketing  Travel Profile 302 1 WORD _
Marketing  Travel Profile 803 1 WORD: Fird..
(3] Marketing iManage Travel Poli... 504 1 WORD:! Delete
Purge
‘| | S
ltems: 3 I Show only echo modified
Close Help

48

Figure 3.4: Checkin/Synchronize Documents dialog box

You can also access the Checkin/Synchronize Documents dialog box from the
Options menu. From the Checkin/Synchronize Documents dialog box, you can
check in documents that you currently have checked out for portable mode or
synchronize echo documents that you edited off line.

To synchronize echo documents:

1. Click the Echo Documents tab,

2. Highlight the documents that you want to synchronize and click the Synch
button.
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To check in checked oﬁt documents:
1. Click the Checkedout Documents tab.

2. Highlight the portable documents that you want to checkin and click the
Checkin button.

The Confirm Synchronize dialog opens.

Confirm Synchronize [ x|

Document Information

= Number: 902
Version: 1
Description:  iManage Trave! Profile

~ Echo Document ~ D atabass Document

&= Last edit date:  06/01/2001 ;‘B Last edit date:  06/02/2001
Last edit time;  12:06:30 Last edit time:  00:02:52
File size: 13.00 KB File size; 19.00KB
Last user; BOWEN Last user BOWEN

- Options
{* Replace Original " New Version " New Document
DK Cancel Skip Help

Figure 3.5: Confirm Synchronize dialog

Choose the appropriate option: Replace Original, New Version, or New Docu-
ment and click OK to synchronize the portable or echo document with the docu-
ment in the iManage library,

Searching for Documents

One of your first tasks in using iManage DeskSite will be to locate documents
that you want to work on. You can locate documents by:

*  Clicking the icon for a saved scarch {8 . This will perform the scarch again
on the database and return documents that meet the search criteria.
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*  Click the Worklist icon €I . This will display the last 40 documents that you
have worked on.

*  Click a Folder icon (7. This will display the documents contained in the
folder.

> Click the Scarch icon | | and entering new scarch criteria.

To perform a search:

Select Search from the Search pulldown nienu or click the Search icon %I
and enter search criteria in the fields provided. Complete information on using
iManage DeskSite’s extensive searching capabilities is available in Chapier 4.

Opening Documents

Once you locate documents that you want to work on in your Document Grid,
you can open thesc documents by highlighting the documents and sclecting
Open f{rom the Document pulldown or right-click popup menu. The keyboard
shortcut for Open is Ctrl-0, iManage automatically opens the document in the
primary application that was defined for this document type.

Note: If you set your left mouse button double click parameter to the Open com-
mand, you only have to highlight the document and double-click to open the doc-
ument. To set this parameter, select Options from the Options menu and click
the Configure tab. Sclect Open from the Default Command drop down menu.

Note: If you attempt to open a document that is currently in your Echo directory
because you worked on it previously and made changes to it that arc not reflected
in the copy on the file server, iManage DeskSite will not let you open the docu-
ment, Since iManage DeskSite copies a document to your Echo directory when
you open it, this feature prevents you from overwriting changes that you madc to
the document. You must synchronize the document before you can open it. Sce
ZSynchronizing Echo Documents into the Network™ on page 192 for more infor-
mation,

Opening from an Integrated Application

If an application is integrated with iManage DeskSite, you can also open docu-
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ments that are containcd in an iManage database from inside the application by
sclecting Open from the application’s File menu. If the application is integrated
with iManage, the iManage Integrated Desktop appears and allows you to scarch
for documents, display your work!list, or view the contents of a folder or saved
search.

If your application is not integrated with iManage DeskSite

If you do not see the iManage Integrated Desktop when you select Open from
an application’s File menu, then the application is not integrated with iManage
DeskSite. To open documents that are located on an iManage databasc in an
application that is not integrated with iManage DeskSite:

1. Locate the document(s) in the database using iManage DeskSite.

2. Use iManage DeskSite’s Checkout E’d function to save a local copy of the
document(s) on your hard drive.

3. Open the document(s} from within the non-integrated application,

4. When you are finished working on the documents, save them again on your
local hard drive.

IMPORTANT!: Do not change the filename of the documents when you save
them.

5. Use iManage DeskSite to check the documents back into the database using
the Checklin function.,

If you are using an application that you think should be integrated with iManage
DesksSite, but you do not sce the iManage Integrated Desktop when you sclect
Open from the File menu in that application, consult your company’s technical
support department,

Viewing Documents

Instead of opening a document, you can view it with iManage View program or
in the iManage Desktop’s Quickview Frame. Documents that are merely being
viewed are not locked or marked as being in use; instead, View or Quickview
makes a temporary copy of the document. Thus, you can still view documents
that are marked as busy (e.g. those that are in use or checked out), even though
you cannot open them. You can view most word-processing, spreadshect, and
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graphics documents in the Quickview frame or iManage View program.

You can only vicw onc document at a time in the Quickvicw frame, To view mul-
liple documents simultaneously in read-only format, you must use the iManage

View program. iManage launches this program automatically when you highlight
the document and click the view icon or sclect View from the Document mcnu,

To view a single document in the Quickview frame:

Highlight a document in the Document Grid and click the Quickview icon '@"ﬂ
or the Quick View tab or select QuickView from the Document menu or
right-click pop-up menu.

To view multiple documents simultaneously:

Highlight multiple documents in the Document Grid and click on the View but-

ton Iﬁ] or sclect View from the Document menu. The documents open in
rcad-only form in the iManage View program.

From iManage View, you can scarch the full text of documents displayed in the
View frame, copy sections of documents to the clipboard, or print documents,
Sce Chapter 7 for more information about the View program.

Note: Documents are not locked in the database while you are viewing them.
You can view documents whether or not they are in usc or checked out of the
database,

Printing Documents

You can print a copy of a document directly from iManage DeskSite. To print a
document:

1. Highlight the document(s) in the Document Grid.

2. Seclect Print from the Document menu.
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Note: Becausc this print routine uscs the document’s native application to print
the document, it is not possible to change the printer setting directly from the
iManage DeskSite application. It will print using the Windows default scttings.

Note: Selecting Print from the File menu prints a list of documents currently
displayed in the Document Grid (i.e, the contents of a folder or search).

Entering Document Profile Information

Whenever you create a new document, a new version of a document, or a copy of
a document, iManage DeskSite prompts you to enter profile information for that
document, Profilc information helps identify the document and cnables you and/
or others to find it easily when performing a scarch of the database. The dialog
boxes used to enter profile information for a new document, new versions of doc-
uments, and copics of documents are all cusiomizable by your database adminis-
trator. For that reason, the dialog boxes that appear in your version of iManage
DeskSite may appear different from the default ones shown on the following
pages. You may sce fewer or more options, fields of profile information may be
renamed, and the names of the dialog boxes may be different,

Table 3.1: Dcfault Ficlds of Profile Information

Default Name of Significance

Field

Database Name of the database in which the document is
stored.

Type This field usually indicates the application that

should be used to open the document.

Class This field classifies the document with a custom
document classification.

Author This field indicates who wrote the document,

Operator This field indicates who edited or worked on the
document (a typist or coauthor),

Security This field lists the document’s default sccurity sta-
tus: PUBLIC, PRIVATE, OR VIEW.
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Table 3.1: Default Fields of Profile Information

Default Name of Significance
Field

User Access (button) By clicking this button, you can specify access priv-
ileges for individual users.

Group Access (button) | By clicking on this button, you can specify access
privileges for groups of users.

New Document, Profile-Default File imported into: \\PARIS\HR\Travel
Database Apply Template
HR :l J ‘I Hnne) V

— Document Profile Fields Ck

Description lrevised travel policy

Author {}l Author
Class O’ Class

Subclass I— _|

Custom3 I—__l Custom3 Cancel
Custclkﬂ l __I Customd

Operator "}W _‘ Bette Owen-Kelley

Type (}I"v*.f ORDS7 | MSWord 97
Comments... | Help |

Private _ _ﬂ Access Rights |

~ Security

Flgure 3.6: Default appearance of the New Document Profile dialog box, which
is used to enter profile information for new documents in the database.

iManage DeskSite remembers the last five values you entered in each field in the
New Profile, New Version, and Edit Profile dialog boxes.

If browse buttons appear next to the text-entry fields in your dialog box, usc these
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buttons to display selection boxes for each field of profile information. You can
also press F2 to display a sclection box. These selection dialog boxes display lists
of availablc options for cach text-cntry ficld. Sclect an option from within the
dialog box and click OK.

iManage DeskSite offers a Type-ahead feature, When you edit profile informa-
tion in a field, you can type the first few characters of the entry and then press
Tab. iManage DeskSilte fills in the entire entry if possible.

The icons to the left of the field indicate if the field is required or whether or not
you have made a valid entry:

o The green exclamation point symbol indicatcs that profile information is
~ | required for this field.

331 The red X symbol indicates that the information entered in this text-cntry
box is not a valid entry for this profile ficld.

[

Ifthe entry is invalid, enter or select a valid entry. If the entry that you nced is not
available, your iManage administrator must create it.

Note: Your system administrator can enable your system to enter Child field
information (such as Matter) without first entering Parent field information (such
as Client),

Setting Access Privileges

If you have the ability to sct the access privileges on your documents (when you
create a new document or when you select Edit Profile from the Document
menu), then you will notice that there are two basic kinds of settings available to
you.

*  You can select a default security setting for the document. This can be PUB-
LIC, PRIVATE, or VIEW,

*  You can specify access privileges for individual users or groups.
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Rules and Definitions:
Public, Private, and View

*  When the default security setting is sct to PUBLIC, then all users who have
access to the library will be able to view and edit the document and its pro-
file information EXCEPT those uscrs and groups of users to whom you spc-
cifically deny access.

*  When the default security setting is set to PRIVATE, then no uscrs have
access to the document EXCEPT the Author and Operator named in the doc-
ument’s profile record AND those users and groups to whom you specifi-
cally grant access.

*  When the default security setting is set to VIEW, then all users have rcad-
only access to the document EXCEPT the Author and Operator named in the
document’s profile information AND those users and groups to whom you
specifically grant full access, read-write access or no access.

Author and Operator Privileges

The Author and Operator named in the document’s profile record ALWAYS have
full access to the document. Only the Author and Operator can change the Author
or Operator of the document or edit access privileges,

Group Access
When a group is granted access privileges to a document, all users who are a
member of that group are granted the same access privileges to the document.

Conflicting Access Privileges

When there is any conflict in access privileges, such as when a user is granted
greater privileges individually, then granted lesser privileges as a member of a
group, the greater access privilege apply. Generally speaking, iManagc DeskSite
always seeks to MAXIMIZE users’ access to documents.

Read-only access...
Means that the user can view the document in read-only form, but cannot make
changes and save them to the library as the same document,

Read-write access...

Means that the user has full view and edit privileges to the document. Users with
read-write access can change profile information for the document, but they can-
not change the Author or Operator, or cdit access privileges. Only the Author or

Operator and those to whom they grant full access can edit these fields.
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Full access...

Means that the user has full view and edit privileges to the document, plus they
can change the security settings for the document. The Author and Operator have
full access, and they can grant full access to others.

No Access...

Means that the user cannot access the document, If a user has no access to a doc-
ument, the document does not show up in any search of the library that he or she
performs. If the document is in a public project, users who have no access to the
document do not sce the document when they click on that project icon.

Editing Security on Multiple Documents

There may be times when you need to edit the sceurity for a large group of docu-
ments at the same time, for example, if a new employee joins your group. You
can edit the security settings on two or more documents in the same operation.
This featurc functions only on documents that are currently checked in; you can-
not edit security on documents that are archived, locked or checked out.

To edit security settings on multiple documents:

1. Highlight the documents whose sccurity you want to edit and sclect Bulk
security edit from the Document menu.

Edit Security

' Security Settings

| Defaul Secury: [HVFSESEES— |

User/Group Security |

' — Set Security Options
i " Bemove existing security settings
(¢ Only 2dd to or modify existing settings

Status:
| . a

ot

(0] Cancel

Figure 3.7: £dit Security dialog
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2, Select the Default Sceurity for all the documents in the Default Security
drop-down list. You can select <no change>, Public, Private or View.

3. Click User/Group Security to add Users and/or Groups who are exceptions
to the default security

4. Choose an option in the Set Security Options group:

* Choose Remove existing security settings if you want to replace the
current setting in all documents with the new settings you are entering,
The sccurity you set will be the same on all the documents you select.

*  Choosc Only add to or modify existing settings to kecp the current
scttings on the documents, but add or change specific users or groups.
The settings you sclect will change but all other settings will remain as
they were.

Creating and Applying Security Templates

When you add a new document to an iManage library, you have the option of
entering custom security settings, including access/denial lists of users and
groups, or you can apply a sccurity tcmplate to the document that will determine
the security settings to be applied to the document. You can only apply a sccurity
policy to a document when you add the document to an iManage library, Once
you add the document to the library, changes to the security policy do not affect
the document’s individual security settings. If you want to make the document
available to other users or change the sccurity settings after adding it to the data-
basc, you must make these modifications to the document individually using the
Edit Profile option.

You can optionally sclect a security policy that should be applied by default to all
new documents in the New Document Defaults dialog box, I you select a default
security policy to be applied to all new documents, that security policy is sclected
by default in the New Document Profile window each time you add a new docu-
ment to the database. Like all values defined in the New Document Defaults dia-
log box, however, you always have the option of selecting a different security
policy or custom security settings each time you add a new document to the data-
base.

To Create a Security Template:

1. Select Security Template from the Options menu. This launches the
Security Template Management dialog.

2. Click New. This launches the Security Template dialog.
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| Security Template E3
Secuiity Template Name: |
Default Security: I Frivate lJ
MName:; \
10 | Name —| Nlow L... | Access Hightﬂ
Step 3
Type of Access: IHead.”"."\"'litE :_I
Add User... £dd Group... | Hemowve |
’ 0K | Cancel Help |

Figure 3.8: Security Template dialog box

3. Enter a name for the template in the Security Template Name text box.
After you enter the template name the enterable ficlds are no longer grayed
out,
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60

Security Template
Security Template Name: |HR Security Templat]
Default Security: |P'i" ale :J
Name:
D | Name \ | AllowL... | Access Highlsl
Step 4
Step 5
Step 6
Type of Access: |Full Access ) i :J
Add User... AddGroup... | Remove |
oK Cancel | Help |

Figure 3.9: Security Template dialog box with name

4. Select a default level of security from the Default Security drop down menu
to assign security access to anyone, except Author and Operator, not
accounted for in your explicit security assighment list. This ficld defaults to
Private. You can also sclect Public or View. (Public = Rcad/Write, View =
Read Only, Private = No Access)

5. Sclect the type of access from the drop-down menu for the users and groups
you specifically name in the template. You can choose from Full Access,
Rcad/Write, Read, or No Access. Sce “Sctting Access Privileoes” on page

33

6. Click Add User or Add Group to add specific uscrs or groups to the tem-
plate.
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Select Internal Group(s)

- rDatabases
[ =]

— Show All Possible Entries that Match

| S . LookUp |

¥ Beginningwith ¢ Contains I™ Extemal Group

| |- Entries:

Group ¢+ | Name | Enabls Flag | Containe

NRTADMIN
QCGROUP
RELEASE

HRGROUP

a

al '
[T T
" | ltem(s) Loaded: 3

oK | Cancel | Help

Figure 3.10: Select Internal Group(s) dialog box

7. Select one or more groups or uscrs from the list. You may select from a list
of cxternal uscrs or groups by checking External Group or External User.
Click Add To>> to add them to the security template.To remove users or
groups from the security assignment list, highlight and delete them from the

Add To list.

AUTEb20061



iManage DeskSite User Reference Manual

Security Template

Secuiity Template Name; IHR Security Template

Default Security: Ip'i\' ate Z|
tHame:

ID ; | Mame | Allow L... | Access Righ =
b H{ADMINISTRAT...  Domain Administrator Y Read

€2 ALEX Alex Zhitlsmok Y Read -
€ ALEXLI Alexander Lifshits Y Read

€2 AMARTINEZ ~ Abel Martinez Y Read

€3 APHILIPS Arthony Philips Y Full Access
€3 BBELMONTE Bl Belmonte Y Read

§> BJONES BrianJones Y Read

€ BOWEN Bette Owen-Kelley Y Full Access
© BXIAN Buian Y Read

§2 BXIANUSER BianUser Y Aead -
4] | | 2]

Tupe of Access: |Read

IR

Add User... Add Group... | Remave |

oK Cancel | Help |

Figure 3.11: Security Template dialog box showing list of groups and users

8. Toremove a uscr or group from the template list, highlight the user or group
and click Remove.

9. Click OK to save the security template.

To Apply a Security Template

Once a security template has been created, you can apply it to any new document
you add to an iManage library, In the New Document Profile dialog there is a
Security Template drop down menu. This menu contains the Security Templates
you have set up. Select a security template and you are finished with the security
aspect of the document’s profile. You can modify the access control lists when
you import 2 document to an iManage library. However, if you assign an author-
bascd sccurity template, you cannot modify sccurity scitings assigned to that
author,
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Using Lookup Dialog Boxes:

If they are provided, use the lookup buttons :_I in the New Document, New Ver-
sion or Profile Edit dialog boxes (or in the Search Dialog window) to enter pro-
file information. When you click a lookup button in onc of these dialog boxcs, a
selection box appears that contains a list of valid entries for that field of profile
information, Figurc 3.12 shows an example of a selection dialog box for the
Author ficld of profile information. Note that you can select either internal or
external authors. To see the list of external authors, simply check External.

Searching in the Selection Box

Il the list of validated entries is long, enter a search string in the Show All Possi-
ble Entries that Match field and sclect whether you wish that string to occur
only at the beginning of the document or anywhere in the document, then click
the Lookup button to search the list.
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j Select Internl Ahor X
- rDatabases
[HR ]
r Show All Possible Entries that Match
| _ Look Up |
* Beginningwith ¢ Contains [~ External User
- Entries;
User ID 2 | Full Name | Allow Login | Loca
ADMINISTRATOR Domain Administrator Y
ALEX Alex Zhitlemok. Y
ALEXLI Alexander Litshits Y
AMARTINEZ Abel Martingz Y
APHILIPS Anthony Philips Y
BBELMONTE Bill Belmonte Y ]
BJONES Brian Jones Y
BOWEN Bette Owen-Kelley Y
DCARTWRIGHT Doug Carbwright Y
DMS DMS Y
DWILSON Y
GASPLAND Geotge Aspland Y
GJOHN Georgee John Y
GLUKHANIN Gennadiy Lukhanin Y
GUEST Guest Y
IDMS1 iManage DMS1 Y
IMAGES Disk Image Account Y g
INDEX INDEX _ Y o
<l T
ltem(s) Loaded: 48
oK Concel | Help

Figure 3.12: Select Internal Author dialog box

Primary Libraries

64

Administrators have the option of assigning each user a primary library. A user’s
primary library is his or her “home” library, It is where the user will store most of
his or her documents; hence, when the user initiates a search or creates a new
document, the user’s primary library is selected automatically as the default.
Users can always sclect a different library, The ability to assign users a primary
(or default) library is intended as a convenience 10 users.
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When creating new documents...

When a user creates a new document, the user’s primary library is initially
selected as the storage location for the document, If the user enters a different
uscr’s name in the author field, and that user has a different primary library, then
the library sclection will switch to the primary library for the user whose name
was cntered in the author ficld. Users can change the library sclection, if desired,
before saving the document.

When performing a search...

Initially, whenever a user opens the Search dialog window, the user’s primary
library will be selected. If the user changes the target libraries for the search, the
new selections will remain in effect until the user changes them or until he or she
closes and restarts iManage.

Editing Document Profile Information

To edit or view profile information for a document:
1. Highlight the document in the Document Grid,

2. Select Edit Profile from the Document menu. The dialog box used to edit
profile information is displayed for that document.
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Profile Edit and View -Default : [ ]

Documnert Number |1 18 LastEditDate  [g/772001
Document Version |1 Last Edit Time |2;1 518 PM
Creation Date |8/?/2I301 Sizs |25.5KB (26,112 bytes)
Last Edted By |__ OK

"Proﬂle Fields
Desciiption  |Aitine Travel Info - , _
Author OBOWEN _I Bette Qwen-Kellzy
Class ojpocc ) _I Document Cancel |
Subclass | _J
Custor3 | o]
Custom4 | _I
Operator  (D|BOWEN ___l Eetle Owen-Kelley Help |
Type O[wORDS? | MSwoid 97
¥ Index Document Comment.. |
— Securily
|View . - =] h *Access Rights |

66

Figure 3.13; Default appearance of the Profile Edit and View dialog box. This
dialog box may appear differently in your version of iManage DeskSite.

Your capacity to edit profile information for a document will depend on whether
you are the Author or Operator for the document and whether you have Read/
Write or Full Access privileges. Only the Author or Opcrator or others to whom
they have granted Full Access can change access privileges on a document. Uscrs
with Read/Write access to a document can edit profile information, but not access
privileges.

Note: Your system administrator can enable your system to enter Child field
information (such as Matter) without first entering Parent field information (such
as Client).
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Checking Out Documents

You can check out individual documents from an iManage database for use out-
side of the iManage system. You may want to edit a document off site or with an
application that is not integrated with iManage DeskSite,

Note: Individual document check-out is different than iManage Portable docu-
ment checkout, See Chapter 6 for information on checking out documents for
portable usc,

The document’s number and version becomes its filename when it is checked
out, For this reason, the document’s filename must remain unchanged if you want
to be able to check it back into the iManage system. If you check out a Microsoft
Word document with a document number of 37 and a version number of 2, the
document will be stored on your local hard drive (or other location) with a file-
name of 37_2.D0C.

IMPORTANT!: Do not change a checked-out document’s filename. Tt is used dur-
ing the document check-in process.

To check out a document:

1. Highlight onc or more documents in the Document Grid and click the

Checkout icon &I or select Checkout from the Document menu. The
Checkout dialog box appears.

2. Ifyou are checking out the documents for portable use, check the Portable
check box,

3. Inthe Destination Path field, enter the path for the directory where you
want to save the checked out documents. If the Portable checkbox is
checked, the documents are saved to the Nrportbl directory. You can use the
browse button next to the Destination Path field to search for a directory on
your local hard drive or the network.

4. Enter a due date for the documents and a reason for checking out the docu-
ments in the comments field.

5. Click OK to checkout the documents.
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Checkout

r Document information
Datsbase: HR

Mumber: p Version: 1

Desciiption:  iManage Travel Policy
i~ Options

™ Portable Checkout

Destination Path: IC:\NF&TEcha 1 J
~ Details

Due Date: | 6/ 7/2001 j

Comments:

(1] 4 Cancel | Help

Figure 3.14: Checkout dialog box

Checking In Documents

Documents that have been checked out can be checked back into iManage

DeskSite easily using the Checkin option.

To checkin documents:

1. Launch iManage DeskSite and click the Checkedout Documents icon <%}
within the Folder Tree. This displays all of the checkout documents for the
selected server in the document grid,

2. Highlight the document(s) that you want to check in.

Note: Select multiple documents in the Document Grid by keeping the Ctrl key
depressed and lefi-clicking the desired documents. If you hold down the the Shift
key and then left click on two documients in the grid, those two documents and all

those in between are selecled.

68
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3. Click the Checkin icon | [2| or sclcct Checkin from the Document meny
to check in the selected documents. A Checkin dialog box appears for each
document to be checked in.

i ~Document Information

Database:

Number: Version: 1

Description:  iManage Travel Policy
— Options

* Replace Original " New Version " New Document
™ Keep checked out
T Detele local file after chieck in

OK Cancel Help

Figure 3.15: Checkin dialog

4. Select either Replace Original, New Version or New Document. To apply
the selected option to the entire group of documents that you’re checking in,
sclect Apply to all documents, The Apply to all documents option appcars
only if you have multiple documents selected,

Note: Your system may not allow you to modify existing documents, In this
case, you can check documents in only as new documents.

5. Click OK to check in the documents and return to the iManage desktop.

Checking in Documents Checked Out on a Different Machine

If you checked out documents to the Portable directory (NrPortbl) on a different
machine, a laptop computer for example, and try to check them in on your desk-
top computer, you receive an error message. You cannot check in the document,
You must check it in on the computer where you checked it out to the Portable

dircctory.

N
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iManage Error ﬂ
One or more documents could not be checked in.
o

oK Details <¢

The operation could not be pefaimed on these document(s) _..J

- Number ;2 Yersion :2(MS Word 97)

The Reason(s):

- The Partable checked out file C:ANPortbh\HRABOWEMNAZ_2.DOC can't be found.
This file maybe on a different mackine.

N

Figure 3.16: Error message you see if you attempt to check in a document that
you checked out on a different machine. Click Details to sec the reason as illus-

trated above.

Checking in Documents Checked Out to a Different Directory

If you checked out documents to a directory other than the Portablc directory
(NrPortbl), for example, your desktop or a diskette, and try to check them in on
your desktop computer, you receive a warning message.
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@ The file 23_1.D0C was chacked out ta [10.5.3.186]C:\Daocuments and
Settings\bowen.NETRIGHT.COM\Desktop\HR_23_1.doc.
Proceed in [BOWEN]C:\Documents and
Settings\bowen NETRIGHT.COM\Desktop\HR_23_1.doc?

Yes No

Figure 3.17: Warning message you see if you attempt to check in a document
that you checked out to a different directory.

The message reminds you of the directory where you checked out the document,
but does not prevent you from checking it in.

Relating Documents

You can create one- or two-directional relations between documents in iManage
DeskSite. Document relations are one of the ways you can organize and group
documents in iManage DeskSite, in addition to folders and document classifica-
tions. Your iManage administrator must enable two-way relations in your system.
Your system can handlc cither onc-way or two-way relationships, but not both,

To create relations between documents:

1. Highlight a document in the Document Grid. If your system is set for onc-
way relationships, this becomes the parent document.

2. Sclect Setup Relation from the Document menu or right-click pop-up
mcnu. The Setup Relation dialog opens and lists any documents that arc
already related to the document.

Or click the Related Documents tab and lock the PushPin. Sce “Document
Results Frame PushPin” on page 37 for more information about the Push-
Pin,
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i Setup Relation X
" Database: HR
Document, 1
D | ¥| Database | Description | Doc.
1By HR iManage Travel Profile _
77 B3 HR iManage Travel Policy
Remove Relation Close

Figure 3.18: Setup Relation dialog

3. Using the Tree Frame and the Document Grid, navigate to the documents
you want to rclate to the document. The documents do not need to be in the
same folder as the parent document.

4. Sclect the documents and drag them into the Related Documents tab, You
can select multiple documents and drag them all at once. Or drag them into
the Serup Relation dialog.

The [ icon appears in the second column from the left in the documents
grid for documents that have related documents.

5. You can see the related documents by highlighting the parent document in
the document grid and clicking the Related Documents tab,

EReleled i Rocymeni TR LDo G lAnnad ave L) NN N .
DIwl Database Desciiption I Doc. Num| Vet...l Author | Class | Edit Data T | Fila Size‘
] By HA iManage Travel Profis 22 1 BOWEN DOC 6/12/2001 5:44:49 PM 46KH
i j HR iManage Travel Policy 2 1 BOWEN DDC 6/12/2001 11:45:36 AM 43KB

L] 47> [M ]\ Document Prafle A Quick View A Related Documents A Document Varsions ) History 7

Figure 3.19: The Related Documents tab of the Document Results Frame
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Depending on how your system is set up, each document you selected is related
in a one-way or two-way relationship, to the original document. The selected
documents, however, arc not related to cach other. For example, if you want to
relate Documents B, C, and D to Document A, the following table shows how the
documents relate,

Table 3.2: Document relationships

Relationship setup Document A relates | Documents B, C, and

in your system to: D relate to:

One-way B,C,and D Only documents you set
up

Two-way B,C,and D A plus any other docu-
ments you set up

Uses for Related Documents

You can use document relations to group documents and their attachments, a con-
tract and its amendments, a contract and riders to the contract, etc. You can also
use document relations to link a “parent” document with the documents that were
used to create it, such as a final report with its inserts, which could be spread-
sheets, graphics files, tables, figures, and charts.

Copying Documents

You can make a copy of a document that is stored in an iManage library by high-
lighting the document in the Table Frame, then selecting Copy from the Docu-
ment menu,

Sclecting Copy from the Document pull-down menu reveals four options:

» Copy: iManage makes a duplicate copy of the sclected document.

+ Copy Document and Open: iManage makes a duplicate copy of the
selected document and opens the new copy of the document in its associated
application,

+ Copy As New Version: iManage makes a duplicate copy of the selected
document and creates a new version of the document, Not available if docu-
ment is checked out.

» Copy As New Version And Open: iManage makes a duplicate copy of
the selected document, creates a new version of the document, and opens the
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ncw copy of the document in its associated application. Not available if doc-
ument is checked out,

When you sclect any of the above options, you arc presented with the new profile
dialog box, where you can enter information for the duplicate copy of the docu-

ment belore iManage adds it to the library, Enter profile information in the New

Profile dialog and click OK 10 save the new copy of the document.

Note: You can copy a document even when it is in use or checked out. The copy
will be a copy of the last version of that document that was saved to the database.
You cannot copy a document as a new version if it is checked out.

E-mailing Documents

You can scnd a copy of a document, a link of a document,or a URL link of a doc-
ument through e-mail from iManage DeskSite.

To E-mail a copy of a document

Highlight the document(s) in the Document Grid and click the Send button, or
select Send Copy from the Send sub-menu of the Document menu. A new
mail message launches with the desired document(s) attached.

Or open a new message in your e-mail application, go to iManage DeskSite and
sclect the documents you want to attach. Then drag the documents to you e-mail
message and drop the documents into it.

To E-mail a link to a document

Highlight the document(s) in the Document Grid and click the Link button, or
select Send Link from the Send sub-menu of the Document menu. A new
mail message launches with the desired link(s) attached.

To E-mail a document URL link

Highlight the document(s) in the Document Grid and click the Send document
url button, or select Send Document URL Link from the Send sub-menu of
the Document menu. A new mail message launches with the desired url link(s)
attached.
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Note: In order to send a Document URL link, your systcm must include an
iManage WorkSite Web Component server.

Refresh

You can use the Refresh option on the Search menu to update the information
displayed in the iManage DeskSite window with the latest information from the
databasc. You can also press F5 to refresh. The refresh option is a quick alterna-
tive to re-performing the scarch or worklist request displayed in the iManage
desktop.

Importing Documents

You can use the import document function in iManage DeskSite to add docu-
ments to an iManage library that are currently stored on your local hard drive or
on some other drive accessible on the network. Use this function to import only a
few documents at a time. iManage DeskSite provides an additional administra-
tive utility for performing mass document importations.

You can sclect a destination folder for the imported document by selecting the
database from the drop-down menu and clicking the lookup button. Then navi-
gate to the folder where you want to place the document. Depending upon how
your system is set up, the document may inherit the security scttings of the folder
where you place it. If your system has this feature turned on, any other security
scttings arc ignored.

Document importation is for documents that have never been stored on the data-
base before,

If you are trying to You should

return a document to the fibrary that | use iManage DeskSite’s checkin
was previously checked out function

return an echo copy of a document to | synchronize the eccho document
the library after you’ve edited it

synchronize an echo document and use the import function to add it to the
you are unable to do so library as a new document
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Find File To Impaort to Folder K E2

Look i I{uleravel _ _ _"J & &% EE

To import documents into an iManage database:
1. Launch iManage DeskSite and log into your WorkSite Middle Tier server.

2. Select Import from the File pulldown menu. A standard windows dialog
box appears so that you can locate and select a file for importation.

3. Usc standard windows techniques to locate the file. Double-click on the file
name to select i,

A standard dialog box [or entering profile information for new documents
will be displayed. Enter appropriate profile information for the document.

4. Click OK to add the file to the library.

P W

IR

el

LA s
T

Mg D actimbrts

4] airfine Travel Info.doc

¥ iManage Travel Policy 3-22-00.doc
4 |iManage Travel Profile. doc
@revlsed travel policy.doc

. 1 File name: I . ) S _"_I Cpen
1 Flesotype:  [AllFios = R Cancel |
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Figure 3.20: Find File to Import to Folder dialog box

5. The new document profile dialog box opens.
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; New Document Profile-Default File imported into: \\PARIS\HR'\Travel

—Database Apply Template
HR =1 [EET - |
— Document Profile Fields Ox,
Description Irevised travel policy

Author OI— ‘__I .ﬁ.;JthUr
Class 0]+ __J Class
Subclass I— __J
Custorn3 I_— J Custom3 Cancel
Custikti I—— ___I Customd
Operator OEDWEN .| Bette DwenKelley

Type (}I'W’DF:DS? | MS Word 97
Comments... | Help |

Private .:I Access Rights |

i

~ Security

Figure 3.21: Sclect the database from the drop-down list; then click the lookup
button next to it to select the destination folder.

6. You can sclect a destination folder for the imported document by selecting
the database from the drop-down menu and clicking the lookup button, The
Select the destination for the document dialog box opens.

7. Navigate to the folder where you want to place the document.

AUT0b20077



iManage DeskSite User Reference Manual

i Select the destination for the document

Select the destination Session

BSE

Selact the destination folder

=l

El@ iManage Databases
=-[3 HR
g Personal Pages

#-6:4 Public Pages

El@ Personal

] Travel|
E‘jl Public

oK

Cancel

Figure 3.22: Select the destination for the document dialog box

8.

Complete the document profile dialog box.

Importing New Versions of Documents

78

You can import a ncw version of an cxisting document by using the Import as
New Version feature,

To import a new version of a document:
1.
2.

Highlight the document in the Document Grid.

Select Import as New Version from the File menu. A Windows Find File

dialog opens,

Navigate on your computer or network to the file that you want to import as
a new version of the existing document.
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Find File to Impott as New Yersion of #22v1 :
Look in; IE}] Travel _"_] - £x E-

7] 1| Airline Travel Info.doc
4 iManage Travel Palicy 3-22-00.doc
Tl Manage Travel Profile. doc

revlsed travel policy.dot

File name: liM anage Travel Piofile.doc _v_l Open
Files of type: All Files = v Cancel
I R |

Figure 3.23: Find File to Import as New Version dialog

4. Click Open. The New Version Profile dialog opens.
5. Complete the New Version Profile dialog and click OK.

Exporting Documents

The document export function is essentially the reverse of document importation:
it copies a document from the library to your local hard drive. If you are planning
to edit a document and then return it to the database later, it is advisable to use
iManage DeskSite’s checkout function, Unlike with checkout, you can only
rcturn an exported document to the database as a new document. Also, when you
export a document, it is not marked in the database as IN USE, so other users
may access the document and possibly update it while you are editing it.

The document export function provides an option to export documents as echo
documents, If you export documents as echo documents, you can edit them and
then synchronize the edited echo documents back to the database. When you
work on the echo copies of database documents, however, the original documents
in the database will not be locked or marked as IN USE. If other users edit the
database document while you are editing the echo copy of the document, you will
not be able to synchronize the document back to the database. Instead, in such a
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case, you can only import it as a new decument, See Chapter 9 for more detailed

information on Echo Documents.

Note: If you attempt to export a document that is currently in your Echo diree-
tory because you worked on it previously and made changes to it that are not
reflected in the copy on the file server, iManage DeskSite warns you that you are
about to overwrite the document in the Echo dircctory. Since iManage DeskSite
copies a document to your Echo directory, by default, when you export it, this
feature prevents you from overwriting changes that you made to the document in
the Echo directory. You can, however, export the document to another directory.

To export a document from an iManage database;

1. Locate the document(s) in the database and highlight them in the document

grid.

2. Seclect Export from the Document menu. The Export dialog box appears,

Export

 Dacument
Database: HR
Number: 23

Description: revised travel policy

Version: 1

~— Opticng
I Echo
File Name: 231

Destination Path; I&\iM anage docs\Admin

oK

Cancel |

Help

Figure 3.24: Export dialog box

3. The default filename is the iManage number and version. You can enter a
new filename in the File Name field if you wish. You might want to use the

document description as the filcname,

4. Enter a destination directory to store the exported documents in the Destina-
tion Path entry ficld. You can browse for a local or network directory by

80
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clicking the browse button.

5. If your system is set up to enable Echoing, you can export documents as
ccho documents. To export these documents as echo documents, check the
Echo checkbox. The Destination Path entry field will be locked when the
Echo checkbox is checked, When you export documents as echo documents,
the destination directory is always NRTECHO, although you can select the
drive on which this directory is stored.

6. Click OK to export the documents.
Displaying Checked Out Information

If a document is checked out, you can display information about the checked out
document by highlighting the document in the Document Grid and sclecting
Checkedout Info from the Document menu.
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i Document Checked Out

~ Document
Database: HR
Number: 23 Version: 1
Description: tevised travel policy
Date-Time: 6/14/2001 2:.03.06 PM
Checkout Pathe [BOWEN]C:\N:PortbhHRV\BOWENY23_1.D0C
~ User
User D BOWEN
Full Name: Bette Qwen-Kelley
Location:
Phone: E stension:;
Fax;
E-Mail R?
PC Location;
Details
Due Date: | 61472000 « l
Comments; _I
ha|

ok Help

Figure 3.25: Document Checked Qut dialog box
You cannot edit any information in this dialog box.
Displaying History of Document Activity

You can display the history of a document’s activity by highlighting a document
in the Document Grid, then clicking the History tab or the History toolbar icon

@j or selecting History from the Document menu. The document history
record displays all activitics of the types selected for recording by your system
administrator. The types of activities typically recorded in the document activity
rccord arc:

*  Opening and closing the document in an integrated application
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* How long the document was open

+  Editing the document’s profile

*  Changing the access rights of the document

*  Printing 2 document and how many pages were printed

*  Checking out, copying, and/or checking in the document
+  Viewing the document

*  Mailing the document through e-mait

»  Creating a new version of the document

*  The computer (location) where the activity took place

*  Comments about the activity

B0 G CA e N R L T AN A QUL AYELE DY) B .

User | Applicati .. | Activity | Date - Time v I Duralicml Pages Prin...l Locatian | Comments

BOWEN WINWORD Checkin  6/14/2001 2:20:48 PM 26 .. OBDWEN

BOWEN WINWORD  Madiy 6/14/2001 2:20:47 PM 0 0 BOWEN

BOWEN MANAGE32 Checkout 6/14/2001 2.20:22 PM 0 0 BOWEN

BOWEN MANAGE32 Cieate Versi 6/14/2001 2:14:33 PM a 0 BOWEN Created from version 1

[ 4[> {MT\_Document Profile A Quick View A Related Documents A Document Versions A History / ‘

Figure 3.26: The Document History tab displays the activity record for a docu-

ment.

You can also print a hard copy of the document activity record. To print a hard
copy, right-click on any activity and select Print from the menu. You can also

sclect Print Preview.,

Unlocking Documents

In some instances, when network connectivity fails or your computer shuts down
unexpectedly, you may find that a document that you were working on when
disaster struck is marked as IN USE in the iManage databasc, cven when you
know very well that it is no longer in use. In such a case, you can unlock the doc-
ument in the library and tell iManage DeskSite to release it, even though you

have not returned the document or checked it in using normal methods.

Only the user who most recently opened or checked out a document can unlock
the document in the library. If you try to open or unlock a document that someone

else is using, you will receive an error message.
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To unlock a document that is marked as IN USE:

1. Highlight the document in the Document Grid.

2, Click the Unlock icon _@ or sclect Unlock from the Document pulldown
menu,

3. A message asking you to confirm the Unlock appcars. Click Yes to unlock
the document.

@ Unlocking document 1.1,
You may lose changes if the document is cutrently open in an Application.
Confirm Unlock?

Yes No Help

Figure 3.27: Unlocking document confirmation message

4. Ifthc systcm detects that the document in question resides on your local
drive, the Confirm Synchronization of Locked out Documents dialog

launches (see Figurc 3.28),
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Confirm Spnchronization of Locked Document

A copy of the document being Unlocked has been found on your workstation's
local drive, select Synch. ta Server to replace the file on the server with the file
on your workstation, Select Ignate to unlock without copying ths local file to the
server,

~ Document Information

Number: 455

Version: 1

Description;

~Woikstation Document———————  — Network Document
' Date: 57191999 Date:  5/19/1939
" | Time:  5:3.20PM Time:  5.02:31 PM
1 Size; 33400[bytes} Size:  O(bytes)
i

~Unlock Document DOption

! ; .
[ Synch. to Server & Unlock lgnore Wkstn. doc. & Unlock
i

Help

Figure 3.28: Confirm Synchronization of Locked Document Dialog

This dialog gives you two choices:

*  Synch to Server & Unlock checks in the local copy of the document and
overwrites the network copy. Use this option if you are sure the local copy is
the more appropriate copy to survive,

+ Ignore Workstation doc. & Unlock unlocks the network copy of the docu-
ment without consideration to the local copy.

Note: The Unlock option may be disabled for some users of iManage DeskSite,

Purging a Document

To purge a document is to remove it entirely from the database, To remove a doc-
ument from a folder, see the next section of this chapter.

You purge a document from the database by highlighting the desircd document in
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the Document Grid and sclecting Purge from the Document pulldown menu or
right-click pop-up menu. Only the author or operator of a document are allowed
to delete a document. This option may also be disabled for some users of iMan-

age DeskSite.

Removing a Document

To remove a document is to remove it only from a folder, It does not remove the
document from the database itself. To remove a document from the database
cntirely, see the previous section Purging a Document.

To remove a document from a folder, highlight the desired document in the Doc-

ument Grid and click the Remove icon ,@J or sclect Remove from folder
from the Document menu or right-click pop-up menu. This option may also be
disabled for some users of iManage DeskSite.

Restoring Archived Documents

86

You can restore archived documents dircctly from the iManage desktop, if the
proper archive files are available to the server, When you try to open or checkout
a document that is marked as archived, iManage displays an alert message that
indicates that the document is archived and ask you if you want to restore it. If
you click Restore, iManage retrieves the archived document from the archive
location, If the archive file is not available to the server, iManage will mark the
file for restoration by your administrator,

uf'?‘) The document 2001 has been aichived
~ Do you mart lo restore the docment and open &7

%] e | bew

Figure 3.29: The Document Archived dialog box presents you with the option of
restoring archived documents immediately.
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Changing Your Password

Your password will expire afier a length of time determined by your iManage
administrator. You will receive 2 warning message before your password expires.

You can change your password by sclecting Change Password from the
Options menu. This launches a Change Password dialog box for the server cur-
rently highlighted in the tree frame. Enter your old password, enter your new
password twice, then click OK. If you use Trusted Login, this iManage password
is not used.

Note: Passwords are database specific. To avoid a conflict, it is important that
you have all databases available when you change your password. If one of the
databases is down and not available when you change your passwords, the new
password will not be updated for that databasc. Then, the next time you log in
with your new password it will be unable to log you into the database that was
not updated,

Change Password | x|

~PARIS
Old Password: [
New Password. |""“"‘“‘

Confirm Password: I""“’i

ok | Cancel | Hep |

Figure 3.30: Change Password dialog box

Setting Default Profile Information for New Documents

You can create a virtual template of default document profile information that
appears in the new document profile dialog box. This option enables you to set
certain ficlds of profile information to standard values that typically do not
change so you do not have to enter the same information each time you create a
document. For instance, if you frequently create documents that have a certain
field of profile information sgt to a constant value, you can enter that value as the
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default value for that field, and it will appcar automatically each time you create
a new document.

To create default values for certain {ields of document profile information, select
New Document Defaults from the Options menu. The information that you
enter in this dialog box will appcar automatically in the dialog box used to enter
profile information for new documents.

Note: Although the values that you enter in the New Document Defauits dialog
box appear automatically in the document profile information dialog box for each
new document you create, you can still edit these values whenever you create a
new document. You do not have to use any of the default values set in the New
Document Defaults dialog box. Each time you create a new document these
default valucs appear automatically for your convenience — to ¢liminate the need
for entering the same values repeatedly.

Special Strings

88

You can specify special strings for the current date, time, date and time, and user
name in the New Document Defaults dialog box. If the following strings are
entered in ficlds in the New Document Defaults dialog box, the following infor-
mation is entered in the profile information dialog box when you create a new
profile for a document:

Table 3.3: Special Strings

String What it does
$DATE Inserts current date
$TIME Inserts current time

$DATETIME Inserts current date and time

$USER Inscrts name of user currently logged in to
database

Figure 3.31 shows an example of a New Document Defaults dialog box where the
default document description will be the name of the current database user fol-
lowed by the datc and time. The author is also sct to the current database user.
The class defaults to DOC,

When you select a security policy in the New Document Defaulrs dialog box,
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then that security policy is selected automatically in the New Profile dialog box
each time you add a new document to the database. You can always sclect a dif-
ferent sceurity profile or enter custom security seitings for a document, if desired.

New document default settings remain in effect until you explicitly reset them.

New Document Profile-Default Default
— Database Apply Template
IHH _ﬂ | IHR Security Template _ﬂ
— Document Profile Fields oK
Description IZUSEHZ'DATETIME

Author W __J testuser
Class | Class
Subclass I—— __J Subclass |
Custom3 I__ _I Custom3 Cancel
Customd I——— _| Custom4
Operator I— _I Operator
Type l_— __J Type

Comments... | Help

;I bocess Rights |

'

W

- Security

Figure 3.31; New Document Defaults dialog box with strings inserted to display
username, date and time
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- CHAPTER 4
Searching for
Documents

.

Overview

iManage DeskSite can perform fast and powerful searches for documents based
on document profile and/or full text information. You can save scarches and
redisplay them by clicking an icon. You can share saved scarches with other
users. You can also display a worklist search for the forty documents that you
most recently edited or accessed by clicking the worklist icon.

This chapter explains how to use iManage DeskSite’s vast searching capabilities,
how to perform searches of the full text index, and how 1o save, share, and
retrieve saved searches.

Types of Searches

There are two types of searches that you can perform using iManage DeskSite:
profile searches and full text searches. You can perform both searches simulta-
neously, The complete text of documents and the comments profile field are both
indexed.

Profile Searches

Profile Scarches are searches of the database based on a document's profile infor-
mation. You can enter scarch criteria for certain fields of profile information and
iManage returns as hits documents whose profile information matches that crite-
ria. Scarch critcria can include wildcard characters. You can select profile ficld
entries {rom table lookup windows. You can specify date ranges through graphic
date-sclection pop-up windows.
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Full Text Searches

Full Text Searches are searches of the full text index based on the occurrence of
words or phrases contained in the actual documents, Full text searches do not
actually scarch through the full text of documents but search in an index of all of
the words that appear in documents in the database, The criteria for full text
scarches can include wildeard characters and/or limitations on the positional rela-
tionship between words. Full text scarches can also find documents based on the
occurrence of individual words, partial words, phrases, and words in a particular
sequence. A simplified, intuitive full text search dialog box is available for users
who do not want to learn verity searching commands and techniques.

Searching in Multiple Databases

Scarches can be performed on single or multiple databases. iManage DeskSite
can scarch onc or all of the document databascs that you arc currently logged

into, Search results appcar in the iManage Desktop window’s Document Grid
area.

Note: Only documents that you have read/write or read-only access rights to are
listed afier a search. Documents that you have no access rights to are never Jisted
when you perform a scarch,

Storing Search Criteria

If you perform searches repeatedly you do not have to re-enter them from
scratch; you can save the scarch criteria and retrieve it for later use. Stored scarch
criteria can be cither public or available only to the user who saved it. Saved
searches also appear as icons in the iManage DeskSite Tree Frame.
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Procedures

Searching for a Document

The general procedure used to search for a document in an iManage database is
described here simply. Scan ahead in this chapter for more detailed explanations
of scarching techniques.

). Launch iManage DeskSite and log into a WorkSite Middle Tier Scrver. (Sce
Chapter 3 for more information on logging into a server.)

2, Click the toolbar’s Search icon LQ?_‘ to display the Search Dialog window or
select Search from the Search menu. On the Search menu you can select a
specific databasc to scarch,

‘ Search..  Cul+F "

! Refresh F5

Database Seaich . ;1;11

imanz2

Figure 4.1: Search menu

Note: The above command will generate the Search dialog assigned to the pre-
ferred database of the uscr, It is possible for an iManage installation to have more
than one Search dialog template. Search dialog templates arc assigned by Data-
base. To access the dialog templates of non-preferred but accessible databases
select Additional Searches from the Search menu.

3. Specify profile information, full text criteria, or both, then click Find. The
results of your search will be displayed in the iManage Desktop window’s
Document Grid.

Saving a Search Profile

1. Launch iManage DeskSite and Login to a WorkSite Middle Tier Server. For
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instructions on logging in, sce¢ Chapter 3,
2. From iManage DeskSite, click the Search icon M to display the Search
Dialog window or sclect Search from the Search mcnu.

3. Enter scarch criteria in profile fields. Use the browse buttons to select entries
from lookup tables.

4. Save the profile by clicking on the Save Search button, The Create New
Saved Search dialog box appears.

Sclect the database in which the search profile is to be saved.
Enter a unique 1D code for the search profile in the Profile Name field.

Enter a description of the search profile in the Description field.

e A

Mark the profile as either public or private by clicking on the corresponding
radio button. Private saved scarches are only available to the user who cre-
ated them.

9. Click the Save button to save the search.
Retrieving a Saved Search

When you retrieve a saved scarch, iManage DeskSite re-performs the scarch
based on the saved search criteria. Saved searches are dynamic and will reflect
any changes in the database each time you click on the saved search.

To display the results of a saved search:

1. Locate the saved search in the Tree Frame (see Figure 4.2).
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= @ iManage Databases
%} Checkedout Docs
-5 Worklist

--{gf] Search History

B imanl

B-F iman2

i.{%% Checkedout Docs
LT Worklist o
&-(Z] Personal :
B-{§] Public

—1y

{8 Public Saved Searches(bow:
E- (i3 Public Saved Searches(Othe
i) JAN'S LASTUSERS
@ MSWord37 docs :
{3 MY_WORDS7 'v |

Figure 4.2: Tree Frame with Saved Searches highlighted

2. Click the icon for that saved search to display the scarch results in the docu-
ment grid.

If you can’t locate the icon for the saved search in the Tree Frame, or if there are
too many saved searches listed, then follow the procedure on the next page for
searching for a saved scarch profile,

To search for a saved search:

1, Click the toolbar’s Scarch icon &_I to display the Search dialog box.

2, Click the Retrieve Search button. The Rerrieve Saved Search dialog box
appcars, This dialog box lists all saved searches that are available to you in
the database.

3. Speccify the database where the search profile was saved using the Database
drop-down list box.

4. Click the Find bution to display the Find dialog box.

5. Enter search criteria in the Find dialog box. Click on the Find Next button
until you locate the Saved Search in the list,
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Aetiieve Search Dialog ‘ B3

Database: [NYDFF]CE _ _-:]

r Currently Defined Saved Searche.s -

Profile Nama | Scope 19 escri ption ] D
Nariheasi ™ "Public " MMCGRATH ™ docsearhd 4
Nosthwvest Public MMCGRATH  Northwest 51
Southwest Private MMCGRATH  Searchl 12
| Find in List

SeaichSting: ISoutheast :_I

In Column ; v )
N . Jia R

Options

Direction
) - ¥ Match Whols Word ¢ Foiward
d ¢ |
i I Hetieve - ™ Match Case { C Backward
| [ Frdne | Hel
il Find Nex Cancel | Help ‘

Figure 4.3: Scarching through available Saved Scarches in the Retrieve Saved
Search dialog box using the Find option.

6. Click on the Cancel button in the Find dialog box to close the Find dialog
box.

7. Highlight the saved search in the list and click on the Retrieve button. The
Search dialog box will reappear with the saved scarch criteria automatically
entered into the appropriate fields,

8.  Click on the Find button in the Search Dialog window to display the scarch
resulls.

Deleting a Saved Search

You can only delete saved search profiles that you created,

1. Click on the flashlight icon for the search in the Tree Frame to highlight it.
2. Hitthe Delete key.

3. You will be asked to confirm the delcte. Click on the QK button to delete the
saved search.
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Printing Search Results

To print a hard copy of your search results:

1. Rcdisplay your scarch results in the document grid, if they arc not alrcady
displayed.

2. Click Print Document List | &,

3. A standard Windows Print dialog box will be displayed, such as the one
shown in Figure 4.4,

4. Set any print options that you want to change in this dialog box, then click
OK.

For information on setting other options for printing search results, recad ahcad in
this chapter.

Print

r Printer

Neme:  ETIREOUTRCMN | Properies |

Status:  Default printer; Ready
: Type: HP LaserJet 5P
r Wheree  \\RODMANT\HPLaser

Comment; 1~ Printtofie

I

F

L Print range ’— Copies

|

|| @ All999 pages Number of copies: I 5
i ) Pages Irom:|1 ) £0:|999 I :I

! V Collste -
Cl T Selection !

0K Cancel

i

Figure 4.4: Example of a standard Windows Print dialog box
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The Search Dialog Window

The Search Dialog window is used to enter search criteria for any type of search
— whether you are searching the full text index or document profile information.
The components, functions and features available in the Search Dialog window

arc defincd below.

Note: The Search Dialog window can be customized and may appear diffcrently
in your version of iManage DeskSite. The dialog box may contain different ficlds
of information and fewer or lesser options. The figure below shows the default

appcarance of the Search Dialog window as it is shipped with iManage DeskSite.
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Click on a browse button to In this bax, select the :
see a selection table of valid databases in which Click here to clear
entries for each field of profile you want to search, all fields.

information. \

[Document Search "I "

Number |250-500 \ i ) Clear |
Version I - \ N
Description | \ Click here to start
-~ |Type [EXCELAERCELIEXCELG ERCELS? | . | | |_--—=~ -~~~ --[the search.
Class - - - +
: l : ; _l Work List ¥
Auhor  [AMARTINEZ APHILIPS BOWEN ] Ay
Operator | | -
Client . | Save Segich...
Matter | I I :
e ) L " Betrieve Seakch... Carcel
LastUser | ;
Edit Date Range From [ 01/01/200 7
Create Date Range From I:Ul" 017200 “"l

v D '
Index | 1. Dpeuments J Local Open
e " Cbmments
Select whether to search the full / Click here to Click here to
text of documents or the com- search through save the search
ments field of profile information. the list of all saved

Figure 4.5: Search dialog

Searching According to Profile Information

You can scarch for documents in iManage databases using two types of criteria:
profile information and full text information. You enter both types of information

in the same dialog box and you ¢an search for documents that meet both kinds of
criteria simultaneously.

The actual fields of profile information that appear in the Search Dialog window
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vary, because this dialog can be customized by your system administrator. Table
4.1 provides a list of the many possible fields that may be used to scarch for doc-
uments in your database.

To search for documents according to profile information:

1. If iManage DeskSite is not running, launch iManage DeskSite and log into
the WorkSitc Middle Ticr Server. If you are working from within an applica-
tion that is integrated with iManage DeskSite, sclect Open from the File
pulldown menu in your application to display the iManage Integrated Desk-

top.

2. Display the Search Dialog window by clicking on the Search icon @ orby
selecting Search from the Search pulldown menu in iManage DeskSite.

3. Enter search criteria in the fields of profile information displayed in the
Search Dialog window. When you click on the Find button, iManage
DeskSite will locate documents whose profile records match the information
entered in the Search Dialog window.

Note: If Lookup buttons are available in your Search Dialog window, these are
an easy and quick way to enter search criteria into search fields, Click on the
Lookup buttons to sclect valid entrics from a lookup table,

Click on Find to display the search results in the Document Grid. iManage
DeskSite will display up to the maximum number of documents. You can change
the maximum number of documents that will be displayed in the Document Grid
as the result of a scarch by sclecting Setup Display Options from the
Options menu.

Table 4.1: Fields of Profile Information that may be searchable in your database

Profile Field | Description

Number The document number is a unique number automatically assigned by
iManage DeskSite

Version Version number of the document (1-999)

Description Long name of document, up to 254 characters

Name Short name of document, up to 16 characters
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Table 4.1: Fields of Profile Information that may be searchable in your database

Profile Field

Description

Format Type | This field indicates which application should be used to open the docu-
ment. In most cascs, this ficld is automatically sct when the document is
added to the database

Author Author of the document

Operator The Operator is another user, who like the author, has read/write access to
the document, its profile information, and can sct document access rights

Class A classification used to help identify the document

Client Another custom classification ficld. This field determines the valid entries
for the Matter field

Matter Another custom classification field used to identify and classify the docu-

ment. The list of valid entries for this field depends on the entry in the Cli-
ent field. (In effect, this ficld can be conceived of as a subclassification)

Custom Fields

Other custom ficlds may appear in the profile information for documents
in your database. These fields may be additional fields used to classify the
document, or numeric entry fields, checkboxes, or date entry fields.

Creation Date

Date document was created or instaltled

Last Edit Date

Most recent date when document was edited

Last EditTime | Most recent time when document was edited
Last User Name of the user who most recently edited the document,
Size Size of the document in number of bytes

Retain Days

This is the number of days that the document can remain inactive in the
databasc before iManage DeskSite tags it for archiving.

Index Flag

Indicates whether the document should be indexed by the full text indexer

Comment

Comment associated with the document, up to 8,000 characters, fully
searchable

A Sample Profile Search

Profile searches are performed by entering information into the profile ficlds in
the Document Search window, Documents arc found that have profile fields that
match the scarch information specificd. This type of scarch is somctimes called a
query-by-form search. In the example below, an Author name and Document
Type are specified. For documents to match the scarch criteria, BOTH fields of
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profile information must match the entries in the Document Search window.

Document Search B

i ‘Numbcr I B Search Databases Clear

i Version | i

: EDescripliun I I :

P Type [WINWGRD R B D

: ig"“ I L H';l Work List "

, jpuber oo ] — =11

| 1II];:nen:slor | fi _I _ _ |

‘u"mg [ o I Save Search.., [

© Mat ‘

i I - I‘—J Hetiieve Search... | Lancel
LastUsor | ‘ _I Y —

Help

Edit Dale Range From |F' 8/23179 vl To |51 62232199 'l
CreateDateRonge  Fiom 104 6231992] 1, [ 6237193 2]

— - — — .."‘ | ® Documents
Index | L _] ¢ Comments J Local Open

Figure 4.6: Sample Document Search window

The documents returned from this search must have CLIFF in their Author field
and WINWORD in thec Document Type ficld.

A More Detailed Search

If you find that your search results include too many documents, you need to
restrict the scope of your searches further. You can restrict the scope of your
search and usually decrease the number of hits by adding more criteria to the
search profile. Below is an example of a more detailed profile search. Fields that
contain no information always match,
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ocument Search
' Number f ] Search Databases Cleat
Versi . EMAIL !

ersion | ;

Desciiption | - ! Partal

Type [WINWORDS e o

Class e :

| - — = ‘—I Work List
Adbor [AMARTNEZAPAILFS BOWEN | . | —
Operator | B \ . _
| Cient [MONTAGE ] Save Search..
Mattas . '
‘ I . | —"I Betrieve Search... Cancel
| LastUser | : __|
‘| Edit Date Range To | 03/01/200 «
. I — Help
.| Create Date Range From |E12/U1“99]' To Irﬂﬂymf’?ﬂﬂ:"l
¢ Documents
.. Local Open
Index | Lo i " Comments J i

Figure 4,7: A more detailed search

Notice the differences between the search performed in Figure 4.6 and the scarch
performed in Figure 4.7. In Figure 4.7, three Authors are specified, a Client is
Multiple Entries in the Same Field

When you specify multiple valid entries in the same field of profile information,
such as in Figure 4.7, where AMARTINEZ, APHILIPS and BOWEN are all
specified in the Author field, iManage DeskSite will return documents in the
scarch results that match ANY of thesc entries. This is different from when you
specify entrics in multiple ficlds of profile information. In Figure 4.6, for
instance, in which information was specified in the Type and Author fields,
iManage DeskSite would only return documents whose profile information
matched BOTH of these ficlds. When you include multiple entries in a single
field of profile information, iManage DeskSite will return documents that include
at lcast one of these entries in that field of profile information. Hence, after the
scarch shown in Figurc 4,7 is performed, all of the documents found will contain
WINWORDG in the Type ficld AND MONTAGE in the Client ficld AND either
AMARTINEZ, APHILIPS or BOWEN in the Author field. The documents
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returned will also have a Create date after 12/01/98.

Note: When multiple entrics are provided in a single scarch ficld, use commas
to separate cach entry.

Wildcard Characters

104

In addition to being able to sclect validated entries from selection lookup tables,
you can also usc wildcard characters to expand and simplify scarches. Wildeard
characters allow you to match only parts of entries in document profile fields.
There are two principal wildcard characters: the asterisk and the question mark.

*  The asterisk or percent sign stands for any sequence of multiple characters

*  The question mark stands for any singlc character

An Example

Let’s say that you want to search for all of the documents pertaining to a particu-
lar client, called The Montage Company. However, because there are so many
documents in the database pertaining to this client, multiple Client classifications
were created. Some of these are:

*  MONTAGE

*»  MONTAGE CO

* MONTAGEEST
* MONTAGE MFG

You could enter all of these in the Client field in the Search Dialog window to
perform a search that would find all of the documents that include any one of
these entries in the Client field of profile information. You could also do the same
thing by entering

Client [MONTAGE* — i

[ s PR CP I “

in the Search Dialog window. MONTAGE* or MONTAGE% will instruct
iManage DeskSite to match any entries that begin with MONTAGE and that are
following by any string of characters.
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If the library also including documents pertaining to The Montage Company that
were classified with the Client classification THE MONTAGE COMPANY, you
could include these documents in your scarch results by adding an asterisk or
percent sign to the front of the entry in the Client ficld, namely:

R —

Clent [MONTAGET

The Question Mark

The question mark is used to match any single unspecified character. 1f you
wanted to match Client field entries of the type:

*  MONTAGEI
+  MONTAGE2
*» MONTAGE3
* MONTAGE4

You could us¢e MONTAGE? in the Clicnt ficld in the Search window.,

Caveat

The danger in using wildcard characters is that you will increase your search
results by including undesired matches. For instance, you could match all of the
example Client classifications mentioned earlier that pertain to our fictional
example, The Montage Company, using this entry in the Client ficld:

Clent  [MONT*
L. ———— =

RO i o . A

However, this entry would also match such possible Client entrics as:

* MONTHLY REPORTS
*  MONTGOMERY CO
* MONTSOON FLOWERS CORP

Wildcard Characters in the Description Field

Wildeard characlers can be particularly useful in scarching the Description field.
By default, iManage DeskSite automatically inserts wildcard asterisks as shown.
This finds all documents that have the terms WINSOR TRUST in the Descrip-
tion field:
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Desciplion _[WINSOR TAUST]

You can change the default in the Advanced Options dialog box ¢xplained in
Chapter 6. If you did not include the leading asterisk, iManage DeskSite would
only find documents whose Description field began with WINSOR TRUST. On
the other hand, if you omitted the ending asterisk, iManage DeskSite would only
find documents whose Description field ended with the terms WINSOR TRUST.

Searching by Document Numbers

One of the most direct ways to locate documents in the databasc is to scarch for
specific document numbers. If you know the document number for a document,
this can be an effective way of locating the document quickly, because every doc-
ument in the database has a distinct document number and version number,

Numbers can be entered in the Number and Version fields in the Search Dialog
window either as single numbers or as ranges. The following scarch would find
documents with the numbers 1, 10 to 20, and 100 to 110 (if they exist), and
would return only versions 1 to 3 of these documents (if those versions exist).

Search Dialog

i

t |Number [t.1020,700110 | 1
' rsn i i R |
. |Description I o L | ‘
- |Tves L R

Figure 4.8: Partial screen shot of the Search Dialog window.

You can also use the less than (<) and greater than (>) symbols to find a range of
document numbers.

Using Lookup Dialog Boxes

The fastest and most accurate way to enter search criteria in the Search Dialog
window is to sclect entries from Lookup dialog boxes. Lookup dialog boxes list
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valid search entrics for cach field of profile information, If the field of profile
information that you would like to use to search the database has a browse button
next to it, clicking on the browse button will display a Selection dialog box and a
list of valid entries from which you can choose.

Below is an example Selection dialog box where you can select or look up values
for the Type profile field.

Select Type

: rDatabases

| fioocs e
. Show All Possible Entries that Match
| | LookUp |

¥ Beginningwith ¢ Contains

" Currently Loaded Type

Description | Aulo | Alias -
M [2mi Pro 3.0/3.1 AMI3 Y
L | Windows Ansi Text ANSI Y |
" | | Visio Files Vvisio Y :
| |Help Map Files HH Y ‘;
| |HTML HTML Y i
{ | 1 Help Files (Misc) HLPMISC ¥ f
| | JPEG image JPEG Y -
| | Tagged Image File Format TIFF Y
| | WordPerfect 5.0 WPFEQ Y
i | |'WordPerfect .0 WPFED VY
i | |'WordPedect 5.1/5.2 WFFS1 Y
| | WordPerfect £/7/8 WFPFB1 Y
.| | QuattroPro for Windows 6/7/8 QUATR.. Y
; Excel 5.0 EXCELS Y o
i | | Presentations Slide Show 7/8 PASHW Y C
© | |MS Excel97 EXCELS? ¥ ! "I

Item(s) Loaded : 3-?

'.QK' | .Eance-l | Help

Figure 4.9: Selection dialog box for Type entries in a sample database,
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Note: The Lookup dialog boxes only displays up to the first 500 valid cntrics
listed for that field of profile information in the database, If there are more than
500 possiblc valid cntrics, usc the Find option at the top of the Sclection dialog
box to locate your entry. When you enter a value in the Find field at the top of the
Sclection dialog box, iManage DeskSite searches the entire list of valid entries
for matches — not just those listed in the Selection dialog box.

The Lookup Feature in all Selection Dialogs

Usc the Lookup featurc at the top of all Lookup dialog boxcs to locate valid
entries in especially long lists. When you enter scarch criteria in the Lookup
field, the table of available options immediately highlights the first match, Click
the Look Up button and the table displays only those options that match.
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Select Type I

' —Databases

[ioocs ]

i Show All Possible Entries that Match

|WordPerfect _ ‘ Look Up |

{* Beginningwith ¢ Contains

. Cuirertly Loaded Type

Description | Auto | Blias l
i‘ WordPerfect 5.0 ‘WPFS0 Y
5 WordPerfect 6.0 ‘WPFED Y
o | WordPerfect 5.1/5.2 WPFS1 Y
i | WordPerfect 6/7/8 WPFE1 Y

ltem(s) Loaded : 4

BK | Cancel | Heb |

Figure 4.10: Sclection dialog box after scarch was performed for the string
"WordPerfect"

Selecting Multiple Entries

Figure 4,10 also shows that you can select multiple entries in the Selection dialog
box before clicking the OK button. When you click OK, all selected entrics
appear in the appropriate field in the Search Dialog window.

Double-clicking an eniry in a Sclection dialog box sclects the entry and returns
you to the Search Dialog window.
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Full Text Searches

Overview

iManage DeskSite’s full text scarches find documents based on the occurrence of
individual words, partial words, and phrases, referred to collectively as rerms.
You can search for occurrences of terms cither in the contents of documents or in
the text of profile comment ficlds. You can also perform a scarch of documents
that are within multiple libraries at once.

Full text searches can be performed in conjunction with profile scarches. The
documents that are found must meet the profile scarch criteria and contain the
words or phrases specified by the full text search,

By default, full text searches are not case sensitive.
Entering Full Text Search Criteria

You can enter full text search criteria at the bottom of the Search Dialog window.,
You can also select whether to search through the entire body of the decument or
the comments ficld of profile information by clicking the Documents or Com-
ments radio buttons. In the example below, the user is searching for occurrences
of the word “car” or “cars” in the full text of documents that were written by
CLIFF and are of the type WINWORD?2:
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Document Seaich [ x|
I
}‘ Numbet [ | Author  [BOWEN P | Seaich Databases ’I
l Versian 7 o Dperator I _ _ T | ) '
} Tyoe winwords .. | '
’} Bock/Marual I ‘_I i -—
! e Search !
; |Aelease | b | !
! | Product | -
i Sava Seaich..
- |Desciiption [ )
, Filename | Retigve Seaich.. ‘
i
i
! |Edit Date Range Fom [Flinsrnasz]  To [Fliommisay] Cloar
Cieate Date Range From |r.]“3fU7F1 % x| To lml_ﬂf'fi?” EERd |
\ Cancel
L e ‘  Dacuments
| carDR ca
. | Index l i 5 s SRR 1——J " Comments
A / A e

/

Enter full text
search queries

Click here for the
simplified full text
search query dialog

creation window.

Select whether to search the
full text of documents or the
Comments field of profile
information.

Figure 4.11: Document Search dialog

Simplified Full Text Searching

A simplificd full text scarch window is available for users who arc not familiar
with Boolcan logic or who do not want to learn how to construct full text scarch
commands. This dialog box enables you to enter key terms or phrases and to con-
struct a simple full text search query automatically.

To access the simplified full text search window:

Click on the browse button next to the Index field, which is used to enter full text
search queries, When you click this browse button, the Find Documents Contain-
ing dialog box appcars:
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Using the

112

[Find Documents Conlaining |

Enter words or phrases separated by commas

. r-&ll of these words .
Arywhere in documert | Near E

New England, North Dakota

KR

- One or more of these words

?

L

' — Exclude documents with these words

' oK Cancel Help

Figure 4.12: Simplified full text search dialog box

Find Document Containing Dialog Box:

You can use the intuitive Find Documents Containing dialog box to create simple
full text search queries automatically. When the Find Documents Containing dia-
log box appears, enter words or phrascs scparated by commas into the appropri-
ate fields. In the topmost field, enter a list of terms which must ALL appear in the
document in order for it to appear in your search results.

The drop-down list box available above this ficld lets you set the proximity with
which these terms must appear near each other. If you select Anywhere in docu-
ment, then iManage DeskSite will return documents in which these terms appear
anywhere in the document, not necessary within any proximity of each other.

If you select Near each other from the drop down list box, then the words listed
in the topmost field must appear within a defined proximity of each other in a
document for that document 10 be listed in the scarch results, The Near field indi-
cates the proximity within which the words in the topmost ficld must appear in
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the document in numbers of words. If the Near ficld is sct to 10 and two words
are listed in the All of these words field, then these words must both appear in a
document and cannot be separatcd by more than 9 words for iManage DeskSite
to list the document in the search results.

In the middle field, enter a list of terms only one of which must appear in the doc-
ument for it to appear in your list of search results.

In the bottom field, enter terms that should exclude a document from the scarch
results if they appear in that document.

Examples

The example in Figure 4.11 finds documents that include both the phrase New
England and the phrasc North Dakota. 1t docs not return documents that contain
the word New and the word England in separate places — these words must be
next to each other and in that order, The same applies to the two terms in the
phrase, North Dakota.

Error Checking

When you click OK in the Find Documents Containing dialog box, iManage
DeskSite checks the syntax of the terms you have entered and reports any error
that you may have entered. If no errors are found, iManage DeskSite constructs a
valid scarch query, which appears in the Index ficld in the Search Dialog win-
dow.

Example with Wildcard Characters

You can also enter wildcard characters in the Find Documents Containing dialog
box, Figure 4.12 shows the use of a wildcard character in the Find Document
Containing dialog box with terms entered in the middle field.
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[ Find Documents Cnnlaig - o

‘ Enter words or phrases separated by commas
\

— &l of these words
Anywhere in document ﬂ Mear 1_

! e

— One or more of these words

| |college, universit™, higher education L

<

~ Exclude documents with these words

< ]

[1]4 | Cancel - ﬂelp

Figure 4.13: Another example of Find Documents Containing dialog box

The example scarch query shown in Figure 4.13 would return documents that
included the term college,or the phrase higher education,or the terms university
and universities.

Proximity Searches

Figurc 4.14 below shows how to enter a proximity search in the Find Documents
Containing dialog box. By “proximity scarch,” we mean a search based on the
proximity of words in relation to each other in the document, not just on their
occurrence in the document,
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[Find Documents Containing |

1

Enter words or phrases separated by commas

¢ All of these words:

[Neareachother =] Near [14]

client,camplaint

One or mare of these words:

Exclude documents with these words:

oK Carcel  Hep |

Figure 4.14: Find Documents Containing dialog box with search criteria entercd
for a proximity search,

In Figure 4,14, the Near each other option has been selected from the drop-
down list and the Near numeric value has been set to 14, When this search is per-
formed, iManage DeskSite finds only those documents in the database that con-
tain the words client and complaint within 14 words of each other. The two words
can appear in any order, but they cannot be separated by more than 13 words.

Search Elements

A query expression is the criteria used to perform a full text search. It is com-
prised of several elements, either explicit or implicit: operators, modifiers, and
terms.
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Query Expression

(shallots AND mushrooms AND NOT anchovies]

T Modifier

Term

Operator

Operators

Opcrators arc codes that represent logic to be applied to a search. Thesc arc listed
and defined in the following section, Operators. To specify an operator in a
scarch, type the operator in less than/greater than brackets and then the word or
phrase that you want to find, as in <STEM> facilitate.

Although operators need not be entered in all caps, they appear in this chapter as
such for the sake of clarity.

Modifiers

Modifiers adjust the default meaning of a given operator. For example, the CASE
modificr would make the WORD operator case sensitive. The modifiers are
listed and defined under “Modilicrs” on page 124.

Simple and Explicit Syntax

You can perform a full text search according to simple or explicit syntax.

Simple Syntax

Simple syntax refers to when you enter just terms with no accompanying codes
or punctuation. iManage DeskSite produces matches as if the terms are preceded
by the STEM operator. Although they are less exact, simple searches net more
matches than explicit ones.

Explicit Syntax

You can use explicit syntax by enclosing a word in double quotation marks.
When you double-quote a word, iManage DeskSile performs a literal scarch;
Jacilitator and facilitation would not be offcred as maiches to “facilitate”.
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Other Syntax Options

Parentheses

Parentheses indicate the order in which the search is to be executed. iManage
DeskSile reads information within parentheses before looking at whatever may
be outside them. For example, suppose you were to enter the following search:

(Homer AND Marge) OR Bart

iManage DeskSite would look for documents that refer to Homer and Marge—
not just one or the other. Any documents that referred to Barr also would be
included.

Parenthescs can also be placed within each other. The following example means,
“Find documents that contain either Ifomer or Marge—it doesn’t matter which—
as long as the document also contains Bart. Also, give me any documents that
mention Lisa.”

(Bart AND (Homer OR Marge)) OR Lisa

Double Quotation Marks to Search for Operator Words

To search for a word that happens to be an operator, such as AND or NOT, put
the word in double quotation marks to indicate that the word should be consid-
ered as such, not as an operator. For example, to search for the phrase Lewis and
Clark, you would enter:

Lewis “and” Clark
Operators

This section lists each of the operators used in full text and profile searches.

Profile Field Operators

Some operators work only in profile fields.

> (Greater Than)

The greater than sign can be used to scarch for documents that contain & value in
a particular profile field that is greater than a specified minimum value. For
example, to select documents with a document number greater that 2500, enter
the following criteria in the Document Number profile field:
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>2500

>= (Greater Than or Equal To)

The greater than or equal to sign scarches for documents that contain a value ina
particular profile field that is greater than or equal to a specified value. To search
for documents with a document number greater than or equal to 2800, enter the
following criteria in the Document Number profile ficld:

>=2800

< (Less Than)

The less than sign can be used to search for documents that contain a value in a
particular profile field that is less than a specified maximum limit. For example,
to scarch for documents with a version number less than 3, enter the following
criteria in the Version Number profile field:

<3

<= (Less Than or Equal To)

Like the greater than or equal to sign, the less than or equal to sign combines the
scarching power of the less than and equal to signs. To search for documents with
a version number less than or equal to 3, enter the following criteria in the Ver-
sion Number profile field:

<=3

Full Text and Comment Operators

The following operators work in full text searches of profile comments and full
documents,

<AND>

This Boolean operator finds documents that contain both terms on either side of
it. Whilc the OR operator broadens a search, the AND opcrator narrows it. Usc
AND to connect terms with different meanings. The scarch query New England
AND North Dakota would find only documents that contain both phrascs; if a
document contained only one of the terms, it would not be included in the scarch
results. Enclosing brackets are optional on the AND operator,
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<NEAR>

The NEAR operator is similar to AND in that only documents that contain both
terms are included in the scarch results; however, NEAR presents matches that
contain both terms close together. For example, suppose you enter the following
search;

lincoln <NEAR> beard

The search criterion finds documents with the words lincoln and beard near each
other.

<NEAR/n>

The <NEAR/n> operator is a more specific variety of the NEAR operator in that
you specify the maximum distance allowed between each term. The N variable
can be any whole number between 1 and 1,024 (exclude the comma in numbers
greater than 999), where 1 indicates that the terms are adjacent. For example,
suppose you enter the following criteria:

jefterson <NEAR/7> crop

The search criterion finds documents with the words jefferson and crop within
seven words of each other.

<0OR>

OR is a Boolean operator that finds documents that contain at least one of the
terms to which it is applied. The OR operator enlarges the search topic and is nor-
mally used to look for terms that have similar meaning or refer to similar sub-
jects. The search criterion louis armstrong OR satchmo would find documents
with one or both of the terms. The enclosing brackets are optional on the OR
operator.

<PARAGRAPH>

The <PARAGRAPH> opcrator scarches for documents that include all of the
given search elements within a paragraph. You can specify search elements in a
sequential or random order.

To get documents that contain variations of the word woembar and the phrase ice
cream in the same paragraph, enter:
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wombat <PARAGRAPH> ice cream

If you scarch for more than two words or phrascs, you must includc the PARA-
GRAPH operator between each word or phrase, For example, suppose you enter
the following criterion:

oak <PARAGRAPH>maple<PARAGRAPH>ash tree

The search {inds all documents that have oak, maple and ash tree in the same
paragraph.

<SENTENCE>

The <SENTENCE> operator scarches for documents that include all of the given
scarch elements within the same sentence. For example, suppose you entcr the
following critcrion:

automobile industry <SENTENCE> afiermarket

The search finds all documents that have automobile industry and aflermarket in
the same sentence,

You can specify words in sequential order by using the SENTENCE operator in
conjunction with the ORDER muodifier,

<STEM>

The <STEM> operator searches for documents that include variations of the
word you specify, as well as explicit matches. For example, to search for decu-
ments that contain a variation of the word distill, you would enter the following
criterion:

<STEM> distill

Matching documents would include the terms distill, distillation, distillery, dis-
tilling, distilled, and distills.

Note: The <STEM> operator is used by default and does not need to be speci-
ficd. To override <STEM>, put the term in double quotation marks.
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<THESAURUS>

This opcrator sclects documents that contain one or more synonyms of the word
you specify. To locate documents containing synonyms of big, enter the follow-
ing:

<THESAURUS> big
Matching documents include words such as large, vast and extensive,

<TYPO/N>

The TYPO/N operator performs approximate pattern matching to identify words
that are similar to the query term. You can use this operator to scarch for docu-
ments that have been scanned using an Optical Character Reader (OCR). Since
the TYPO/N operator must scan the entire index to find potential matching
words, this operator is not practical for use in databases containing over 100,000
documents or in performance-sensitive environments.

If you wish, you can specify a variable (N) to define the maximum number of
errors between the query term and a matched term, This value is called the error
distance. If you do not specify an error distance iManage DeskSite uses 2 as a
default. This means that there can be a maximum of 2 differences between the
query term and the matched term. An error is defined as a character insertion,
deletion or replacement. For example, the following table shows word matches
with an error distance of 1:

Query and Term Matching Term Explanation of Error
<TYPO/1> Mouse House H replaces M
<TYPO/1> Agreed Greed A is deleted

<TYPO/1> Cat Coat O is added

The following table shows a word match with an crror distance of 3:

Query Term - Matching Term Explanation of Error
<TYPO/3> Sweeping | Swimming I, m, m replace e, e, p respee-
tively
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The following table shows a word match with an error distance of 2:

Query Term Matching Term | Explanation of Error

<TYPO/2> Swept Kept; wept S is deleted and K replaces W;
S is deleted (1 error does not
exceed the maximum error dis-
tancc of 2)

<TYPO> Swept Kept; wept Same as above since the error
distance 2 is the default

<WORD>

The <WORD> operator searches for documents that include a given word. For
example, 1o search for documents that contain the word carrot, you could enter
<WORD> carrot. The WORD operator is only nceded when you want to usc a
modifier, such as CASE, as a search term.

<WILDCARD>

Using wildcard symbols lends a great deal of flexibility to full text searches.
Wildcards can be used when searching for word prefixes, roots, suffixes, plurals,
and to find words that have variations in spelling. The wildcard characters recog-
nized by iManage DeskSite are listcd in Table 4.2, Use the <WILDCARD> oper-
ator to indicatc when you are using wildcard symbols.

Note: Wildcards usually increase the scope of a full text search and can also
increase the time it takes to complete them. In particular, using a wildcard sym-
bol at the start of a word can greatly increasc scarch time, because every entry in
the index must then be scarched,

Table 4.2: Wildcard Symbols used for Full Text Searching

Symbol | Explanation

The question mark replaces any single alphanumeric character, For example,
<WILDCARD> b?m would match born, barn, or burn, Similarly, <WILD-
CARD> ?andy would match candy, dandy, or sandy. You can usc more than onc
question mark within a term; for example, WILDCARD sh?%e could produce
shore and shade as matches,
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Table 4.2: Wildcard Symbols used for Full Text Searching

Symbol | Explanation

The asterisk is used to represent any number of alphanumeric characters (includ-
. ing none). For example, WILDCARD *vert* would match convertible,
inverted, vertigo, and covert. When using the asterisk wildcard, try to narrow
the potential scope of the wildcard entry as much as possible. For instance, to
find documents about automobiles, the critcrion WILDCARD auto* finds the
words auto, automobile, and automotive, but it would also find autobiography,
autocracy, and autegraph. A more specific query is <WILDCARD> auto OR
automo®.

Brackets tcll iManage DeskSite to find one of any character within the brackets.
[] For example, <WILDCARD:= r[aou]t would match documents that contain rat,
rot, Of rut.

When you enclose a caret (*) within brackets, the scarch excludes the string of
characters to the right of the caret. For example, if you enter WILDCARD
‘[*block]head", the term blockhead is not included in the search results. Note
that you must place the caret before the string of characters you want to exclude,
for example WILDCARD *[*block]head®, but not WILDCARD *[block”]head®.

When you enclosc a hyphen (-) within brackets between two letters, iManage
DeskSite looks for every term within that alphabetical range inclusively. For
example, suppose you were to enter WILDCARD ‘a[a-w]a®, iManage DeskSite
looks for every matching three-letter term from aaa to awa,

Note: When you use brackets, you must cnclose the word that contains charac-
ter string with backquotes (‘). The character string cannot contain spaces.

Braces are similar to brackets but let you search for groups of characters, scpa-
{} rated by commas. For example, <WILDCARD> spill{s,age,ing} would match
documents that contain spills, spillage, and spilling.

Note: When you use braces, you must enclose the word that contains character
string with backquotes (‘). The character group listing cannot contain spaces.

Literal Searches for Wildcard Characters

If you want a wildcard character to be interpreted as text and not as a wildcard,
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precede the character with a backslash (\). For example, if you wanted to search
for the term M*A*S*H, you would enter <WILDCARD> m\*a\*s\*h,

Modiﬁérs

Modifiers finc-tune the performance of your chosen operators. For example, you
can usc the <CASE> modificr with the <WORD?> opcrator to make the scarch
case-sensitive,

<CASE>

The <CASE> modifier makes <WORD> and <WILDCARD> searches case-sen-
sitive, For example, the criterion <CASE> <WORD> President would retrieve
documents that contained the word President; occurrences of president or PRES-
IDENT would be ignored.

<NOT>

Used with the AND and OR operators, NOT tells iManage DeskSite to exclude
documents that contain a given term. For example, to retrieve documents that
contain the words mushrooms and olives but not the word anchovies, you would
enter:

mushrooms <AND> olives <AND> <NOT> anchovics

<ORDER>
The <ORDER> operator matches terms based on the order in which they appear

in the query expression. This modificr can be used with the NEAR/N operator.

The ORDER modifier must appear in front of the operator name. For example, if
you wanted to scarch for the word iced followed by the word mocha in the same
phrase, you would enter the following criterion:

iced <ORDER> <PHRASE> mocha
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Overview

The iManage Integrated Application Operation allows a user to perform iManage
functions directly from the application they are using. This integration eliminates
the need to switch to the iManage DeskSite application to perform certain iMan-
age tasks.

iManage DeskSite is actively integrated with most major Windows applications,
including:

*  Microsoft Officc 97 and 2000 Novell GroupWisc 5.2 or 5.5

+  Corcl WordPerfect Suite (8)and «  Microsoft Outlook
WordPerfect Office 2000

*  Watermark Professional *  Any MAPI compliant E-mail

* Any ODMA-Compliant Applica- *  Lexus/Nexus Office Suite 7.x
tion (ComparcRite, CiteRite, Check-

Rite, FullAuthority)

«  Lotus Notes

In addition, if you arc using Microsoft Office 2000, anothcr intcgration option is
available, called Passive Integration. This is an option that your system adminis-
trator may sct, according to the needs of your system,
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What does it mean to be “integrated” with other applications?
Active Integration
When iManage DeskSite is integrated with another application, certain functions

in the other application are slightly changed. The functions usually affected are:
Open, Close, Save, Save As, Insert, Print, and Exit.

There arc also new commands that exist only in integration mode, They are:
Local Open, Local Save, Versions and Edit Profile.

Passive Integration

When the Passive Integration option is set on systems using Microsoft Office
2000, the iManage Open and IManage Save As menu options become avail-
able.

Non-Integrated Applications

In some cases, an application cannot be integrated with iManage DeskSite. In
those cases, iManage DeskSite’s functions will not be available from within the
application. You can still organize, track, and store your documents using iMan-
age DeskSite. You will need to, however, follow this general procedurc to open a
document:
1. Launch iManage DeskSite and log into a WorkSite Middle Tier Server.
Search for and find the document that you want to open.
Checkout the document from the database.

2
3
4. Launch the application, if it is not already running.
5

Open the document from within the application.
When you are finished cditing or revising the document;

1. Launch or switch focus to iManage DeskSite.

2. Use the Checkin option to copy the revised document back to the database.

Startup

In most cases, when you first launch an integrated application, the application
automatically detects whether iManage DeskSite is running and launches it if
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necessary. In other cascs, the integrated application launches iManage DeskSite
when you select an integrated function from the File pull-down menu.

If iManage DeskSite is running but you are not logged into an iManage server,
iManage tries to log into a WorkSite Middle Tier Server. 1f Autologin settings are
available, iManage DeskSite tries to do this automatically. If Autologin scttings
are not available, or if iManage DeskSite is running, but you arc not logged into a
WorkSite Middle Tier Server, the Register Servers dialog box appears, as shown
in Figurc 5.1.

D T
JJ File Edit View [nsert Formet TYools Table Window Help
IDSEESRY BRI~
|[Normal """+ iTimes NewRoman #:10 » | B 7 U
M RN | Register Servers i a TR KRG
ig « v 10 v i Register Server
| | Enter Server Name: || B _vJ Pegster |
i - Registered Servers
)
|
)
!
i
|
f
:
oiel=(«l | - o
© Urnrenister Feronnect Close | Help |
fPage |  Sec !

Figure 5.1: Login to iManage Server dialog from an integrated application

1. Typc the name of the server in the Enter Scrver Name ficld, the click Regis-
ter. The Login dialog box opens,
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O =
_U Eile Edlt Yiew [Insert Format Ioois Table Window Help
== >
DsRESR Y| EE‘,G'| o Q@ BmEE |G
e ,‘f.‘a;;ra;;ﬁsm“aai‘; 5~ B 7 U ||—-§ ==(=EE
N L | BT R R - 1| I = (S
+ i ~Register Server
- (_E_ntat Server Nama: |PARIS
E Sepver Name: IPIJ': 15
t—-LoginInfurmation —
r- terney ot
i TigutoLogn
ii I i Use Trusted Lagin
i UserD: | ;
{ Password: | ;
{ Logii . | . Cancel | -7 Help’ I
o|E| 3] 4 A T N SRR
- Llrmegister |”Hecogne:1| © Cloge | * Help |
Page 1  Sec I 7o furrd [

Figure 5.2: Login dialog box in an integrated application

2. Select the type of Login that you want to use. See Chapter 3 for more infor-
mation about connecting to the DMS.

3. (Optional) Complete the UserID and Password fields. You will complete this
step only if Login that you have sclected requires this information,

4. Repeat Steps 1 through 3 for each server you want to use and then ¢lick
Close.
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File Menu From within Integrated Applica-
tions

Active Integration

An application’s file menu changes in a number of ways when the application is
integrated with iManage. The figure below displays what the MS-Word 97 File
menu looks like when integrated. Many of the command’s behaviors change and
some new options appear, This section details each of these commands,

—
iEile;
D New... CtrhN
& open... Ctr+O
Local Open..,,
/ Closs
Save Ctrl+5
k Save As...
| Local Save As.., | Functions
New F Versions... changed by
menu active inte-
options Page et gration
LGy Print Preview
j@ Brint... Ctri+p
‘; Send To 4
[ edt Profis |
Properties

1 C:\Program Files\...\WORD8\Instwd97.doc
2 C:\My Documents\...\um_03rev.doc

3 C:\My Documents?.. .\um_03.doc

4 Ci\Program Files\.. .\netright.dot

Exit

Figure 5.3: File menu from Microsoft Word 97 while in Active Integration mode
with iManage DeskSite.
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Open:

When an application is integrated with iManage DeskSite, and a uscr selects the
Open command in the application, iManage launches the iManage Integrated
Desktop. The next scction of this chapter outlines all the functionality of the
iManage Integrated Desktop.

Local Open:

The Local Open command exists only if the application is integrated. Sclecting
it launches a standard Windows Open dialog box, which you can use to locate
files on your local hard drive or on the network. You can use this option to open a
document that is not in an iManagg library.

Save:

If the document alrcady exists in iManage DeskSite the Save command simply
rcplaces the original document, For documents that do not exist in an iManage
DeskSite the Save command launches a New Document Profile dialog to allow
you to enter profile information for the new document,.

Save As:

When you sclect the Save As menu item from the File menu in an integrated
application the Save As Options dialog box is launched. You now have three
options:

Savesﬂplius ] D xl

i
1
il
|‘
!

— Document [nformation

Number: 1093

Version: 1

Description:  Telephone List

" Replace Driginal " New Version

[

I

‘“ — Options
\

i

|

0K ~ Cancel " Help

Figure 5.4: The Save 4s Options dialog box appears when you select Save As
from the File menu in an integrated application,
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+  Save as a new document: This launches a New Profile dialog box. Enter the
new document'’s profilc information.

*  Save as a replacement for the original document; This saves the docu-
ment as the same document number and version. It replaces the iManage
DeskSite version. This option is, in effect, the same as sclecting Save from
the File menu. If you have read-only access to the document you cannot use
this option. Instead, save the document 2s a New Document or New Version
of the original document.

*  Save as a new version of an existing document: iManage DeskSite auto-
matically assigns a ncw version number to the document and a dialog box
displays to enter the new version's profile information.

If your application is ODMA-compliant, iManage DeskSite remembers the
option you used the last time you performed the Save As command and uses
that option as a default. However, your system administrator can sct a specific
option to use as the default all the time.

If the active document does not exist in iManage DeskSite when you sclect the
Save As command, then a New Profile dialog opens for you to enter the new
document's profile information,

Local Save As:

When you select Local Save As from the File menu in an integrated applica-
tion, a standard Windows Save 4s dialog displays. Use this dialog box to save
your file on a local hard drive or other directory available on the network. When
you use the Local Save As option, you are saving the file independently of
iManage DeskSite and any libraries to which you may be connected. If your doc-
ument originated from an iManage database, the Local Save As option docs
not automatically update the original copy of the document with any changes you
may have made.

Note: The Local Save As command is a convenient method of making a copy
of a document outside the iManage DeskSite document management system.,
Simply open a document that is in an iManage databasc, then use the Local
Save As command to save a local copy of it. The Local Save As option is
cquivalent to using the Export function in iManage DeskSite.
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Note: Local Save As and Local Open may be disabled in sclected applica-
tions by your system administrator.

Print:

Printing documents in integrated applications is the same as printing documents
in non-integrated applications. The only difference is that the document’s activity
history in iManage DeskSite is updated to show that the document was printed,
how many pages were printed, and who printed the document. If a document is
printed that docs not currently exist in iManage DeskSite, a warning message
may appear.

Edit Profiles:

When you sclect Edit Profile from the File menu in an integrated application,
iManagc DeskSite’s standard dialog box for viewing or editing document profile
information appears. Users who have rcad-only access to a document cannot
change the information displayed in this dialog. Users with read-write access can
change certain fields, such as the comments. Only the Author and Operator of a
document have the full authority to change such criteria as the access privileges
to the document.
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Profile Edit and View -Default . - 5 ardminsira s R 2 |
Document Number [2sa  LastEdtDate  [g5/m
Document Version [ LastEdtTime [3:15:41PM
Creation Date W Size [0bytes (0 bytes) —
Last Edited By I— ' ' ' oK
-~ Profile Fislds
Description  [Entollment Form
Adhot  QFVINGENT ... | PemelaVincet |
Class ()IDOC _| Document Cencel
s [ ]
: Custom3 | _|
Eustomd | - '_I : .
Operator ~ {}BOWEN "_... | Bette DwenKelley  Help
‘ Type OfWOFDS? i .. | MSWord97
‘ ¥ Index Document ‘ Comment... |
— Security -
|I3ubl|c o _‘;I " Access Rights |

Close:

Figure 5.5: The default appearance of the Profile Edit and View dialog box. Your
system administrator can customize this dialog box.

You close a document in an integrated application the same way you close a doc-
ument in the non-integrated application. Whenever you close a document in an
integrated application, you will be given the option of saving the document if the
contents have changed since the document was opened. Figure 5.6 shows an
cxample of the message box that you will receive when you close a document in
an integrated application.
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Manage K

' @ Do you want to keep the changes you made to '2609_2.00C"?

.................

Figure 5.6: Example of the message box that appears when you close a docu-
ment in an intcgrated application,

If you sclect Yes from this message box, iManage DeskSite responds as if you
selected Save from the File menu. Ifthe document is not already in an iManage
databasc, you arc prompted to enter profile information for the ncw document.

Passive Integration

If you are running Microseoft Office 2000 applications, your system administrator
may set up passive intcgration, Most menu options remain the same as with
Active Integration. There arc a few differences.

For more information about using infoLook with Microsoft Office 2000 applica-
tions, sce the iManage QOffice 2000 Integration Module Installation and User s
Reference Manual,
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Eile . S _
O pew... CtrHN
] Manage Open...| Functions
New - Close - changed by
menu ‘ passive inte-
e gration

=
options Save
‘ Manage Save As...

(93 Save as web Page..,

I versions...
|

Web Page Preview

7 Page Setup..,
i[ & Print Preview

[é Print...

Send To »
Properties
Send iManaga Link

ED Edt Profle. ..

1 €. \admintiManags Travel Profile, doc

2 ¢\, \adminlairline Travel Info.doc

3 C:\.. \Employee Benefits Contact list..,

4 C:\NrPortbliimani\BOWENY1018152_1.DOC

Exit

Figure 5.7: File menu from Microsofl Word 2000 while passively integrated

with iManage DeskSite

Open
The Open command launches a standard Windows Open dialog box, which you
can use to locate files on your local hard drive or on the network. You can use this
option to open a document that is not in an iManage library.

iManage Open

When an application is passively integrated with iManage DeskSite, and a user
selects the IManage Open command in the application, iManage launches the
iManage Integrated Desktop, explained in detail in th next section.
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Save As

When you select Save As from the File menu in a passively integrated applica-
tion, a standard Windows Save 4s dialog opens. Use this dialog box to save your
file on a local hard drive or other directory available on the nctwork. When you
use the Local Save As option, you arc saving the file independently of iMan-
age DeskSite and any libraries to which you may be connected. If your document
originated from an iManage database, the Save As option does not automati-
cally update the original copy of the document with any changes you may have
made.

iManage Save As

When you select the iManage Save As menu item from the File menu in a
passively integrated application the Save As Options dialog box launches. You
have three options:

Save As Options E3

— Document Information
Databass:

Number: Version:

Description:

~ Options

" Rertace Grginal  Hew Version * New Document

Save As Type: Microsoft E xcel Workbook v I

oK Cancel | Help

Figure 5.8: Save As Options dialog box for Microsoft Office 2000 applications

*  Save as a new document: You may sclcct the Save As Type by sclecting
from the drop down list. The list is the same as the list you would see in the
Microsoft Office 2000 application you arc using. When you click OK, a New
Profile dialog box launches. Enter the new document's profile information,

* Save as a replacement for the original document: This saves the docu-
ment as the same document number and version. It replaces the iManage
DeskSite version, This option is, in effect, the same as selecting Save from
the File menu, If you have read-only access to the document you cannot use
this option. Instead, save the document as a New Document or New Version
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of the original document. This option docs not allow you to select the Save
As Type from the drop down list,

Save as a new verslon of an existing document: iManage DeskSite auto-
matically assigns a new version number to the document and a dialog box
displays to enter the new version's profile information. This option does not
allow you to select the Save As Type from the drop down list,
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iManage Integrated Desktop

As has been detailed carlicr in this chapter, iManage documents can be accessed
directly through an Integrated Application. The Integrated Desktop is the dialog
that appears instead of the standard Windows dialogs that normally appear in
non-integrated applications,

- Sewver: |PARIS ,-;I(M Seach » JJ ShowFields <P Back = Forvard
g Browse | _Dg_tgbase| Description | Doc. Num | Version | Auther | Class | Edit.. © | File!
B (& iManage Databases v EJFi.. Finance.. _ 284 ) 1, NAT.. DOC BA5/01.. 1§
(%} Checkedout Docs|| [E{H.. tools 35 1 NRT.. PA. S/15/0L.. ,
Y Workls) BIHR 10202001 19 1 GJO.. LE.. 6ASOL. 10
»»»» $,; Search :
B-3 Finance :
E'-}- Personal Page
[#-¢&] another m .‘
B3] ddd )
&-43}] Documen
B)-4z] Marketing i
El 7] MBM Pioj ‘
-- i:] No projec :
| @D notify fact :
i B}<3] one more
| B-4) G4Budge i
B @Y Public Pages i
&-{5J Public
&-[ Private Savec| Database: |Financa JVI Location; I\.\PARIS\Worinst_ o
f1 {1 Public Save Iﬁ_ , ‘ — —
% Public Saveg Hlfmbe“ - . 1 Yersion: l . —:I | Open |v|
=-53 HR Fitter Conditions:
: ‘ o {Type I vl_J Last Modified: |Any Time 3"| _Can—cell
. ,‘l : | ’ s s . .
: IManage ™ |3 Document(s) Found.

Figure 5.9: Integrated Desktop Main Window

Integrated Desktop: Main Window

Tree Frame:

On the left side of the Integrated Desktop is the Tree Frame. It contains the orga-
nizational structure of all servers, libraries, iManage WorkSitc pages if any, fold-
ers, worklists and saved searches, Clicking a page icon displays the folders listed
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on an iManage WorkSite page. Clicking a folder icon displays the contents of
that folder in the Document List.

Pages

If Pages were created in the iManage WorkSite application, you can sce the page
structurc in iManage DeskSite. You can access documents from folders on these
pages and perform all activitics on them that you can perform to documents in
other folders. The activities you can perform depend on your Role and the access
rights you have to the Pages and Folders. You cannot create Pages in the iManage
DeskSite application.

Folders

Libraries contain folders, which are static groups of documents you can create or
share with other users. Folders provide a method for organizing and sharing doc-
uments easily, To display the contents of a folder, click the icon for that folder
and the documents within it appear in the Document Grid.

Document List:

All the documents of a highlighted folder in the Tree Frame arc displayed in this
Document List view. You can organize the list in Ascending or Descending order
by clicking the column heading,

You can also narrow the focus of documents in the Document List by using the
Document Number and Document Version pull-down menus in the Filter Condi-
tions section at the bottom of the window.

To configurc which columns appear in this Document List, click

':ﬁshuwﬂe[ds The Document List Column Selection dialog launchcs.

Shortcut Bars:
The Browse Bar contains the Folder Tree to locate any document on the server
you are logged on to. A user can create Shortcut bars bencath the Browse Bar to
keep folders. The iManage Shortcut Bar exists as a default and can not be
deleted.
To Create a Shortcut Bar:
1. Right-mouse click on the iManage Shortcut Bar.

2. Select Add Group from the pop-up menu.
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3. Name the new group in the space provided.

4. Click on any other Shortcut Bar,

To Delete a Shortcut Bar:
1. Right click once on the Shortcut Bar you wish to delete.,

2. Select Remove Group from the pop-up menu.

To Insert Folders into your Shortcut Bar:

1. Inthe Folder Tree, right-mouse click on the folder you would like to add to a
shortcut bar,

2. Inthe menu displayed, select Add to Shortcutbar.

3. Sclect the specific Shortcut Bar where you wish to inscrt the folder.
Integrated Desktop: Searching for Documents

New Search

Click Search at the top of the Integrated Desktop Window to perform a standard
iManage scarch. The Search dialog form is customizable so the options available
on the form vary, The Document Search dialog is designed in the iManage Dialog
Editor application that is usually not accessible by anyone but the System
Administrator, For detailed information on scarches, sce Chapter 4: Searching

for Documents,

Navigation Buttons

Forward

Click Forward to navigatc to a folder lower in the tree structure that you looked
at previously and then moved back from.

Back

Click Back to navigate to a folder higher in the tree structure.

Integrated Desktop: Document Commands

Open, Insert, Insert Link, etc

The user launches the Integrated Desktop most often because he or she simply
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wants to access a document in iManage. If you reach the Integrated Desktop by
clicking Open from an application’s File menu then you most likely just want to
open the document in the application. To do this, double-click the document, If
you reach the Integrated Desktop by clicking Insert File or Insert Link from an
application, navigate to the document and click open. iManage inserts the docu-
ment or link at the point of your cursor. You can perform all the usual functions
from the Integrated Desktop.

Versions

To view a list of document versions, highlight the desired document and right-
mouse click. Sclect Versions from the pop-up menu,

History

To view the document history of a particular document, highlight the desired
document and right-mouse click. Select History from the pop-up menu.

The History dialog displays the activity record for a particular document in chro-
nological order. The fields displayed in the activity table arc User, Application,
Activity, Date-Time, Duration, Pages Printed, Location, and Comments, The
Document History tablc is not customizable.

The kinds and number of activities recorded for this history is up to your system
administrators but typically include:

*  Opening and closing the document in an integrated application.
*  How long the document was open.

» Editing the document’s profile.

*  Changing the access rights of the document.

* Printing a document and how many pages were printed.

*  Checking out, copying and/or checking in the document.

*  Viewing the document.

*  Mailing the document through e-mail,

»  Creating a new version of the document

»  The computer (location} where the activity took place.

* Comments about the activity.

Related Documents

To view related documents, highlight the desired document and right-mouse
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click. Select Related Documents from the pop-up menu.

Document relations arc one of the ways you can organizc and group documents,
in addition to folders and document classifications. See Chapter 3 for more infor-
mation about related documents.

Edit Profile

To Edit or View a document’s profile information, highlight the desired document
and right-mouse click. Then choose Edit Profile from the pop-up menu.

The Edit Profile dialog box displays the document’s current profile information.
You can cdit the information displaycd in these ficlds and then record your
changes. For detailed information on document profiles sce Chaprer: 3: iManage
DeskSite: Basic Functions.

Checkout

To checkout a document from the Integrated Desktop, select the document(s)
from the Document List and right mouse click. Then choose Checkout from
the pop-up menu.

Use this Checkout feature when you want to work on a document outside the
Document Management System (i.e. on your local workstation, away from the
network) AND you intend to return the document to the system as the same doc-
ument. The Checkout feature will prevent anyone else from editing the document
while you have it.

Checkin

To check in a document that is marked checked out, select the document(s) from
the document table and right-mouse click. Then choose Checkin from the pop-
up menu;

The Check In Options dialog box essentially ‘puts back’ a document that you
previously checked out.

This dialog box presents a number of check-in options:

*  Replace Original: The checked in copy of the document replaces the origi-
nal in the database,

*  New Verston: The checked in document is added to the database as a new
version of the original document. The original document remains intact.
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*  New Document: The checked in document is added to the database as a new
document.

*  Keep Checked Out: The checked in document remains on the local drive.
However you will no longer be able to check the local copy back into the
database.

*  Delete Local File: The local file is deleted afier adding it to the database.
(This option does not apply if you are checking in portable documents.)

Checkedout Info

If a document is checked out, you can display information about the checked out
document by highlighting the document in the Document Grid and sclecting
Checkedout Info from the pop-up menu.

Export

To Export a document, highlight the desired document and right-mouse click.
Select Export from the pop-up menu.

The document export function is cssentially the reverse of document importation:
it copics a document from the library to your local hard drive, If you arc planning
to ¢dit a document and then return it to the databasc later, it is advisable to use
iManage DeskSite’s checkout function. See Chapter 3 for more information
about exporting documents.

View

To View a document, highlight the desired document and right-mouse click.
Sclect View from the pop-up menu,

The View command launches a read-only version of the selected document in the
iManage View application, See Chapter 7 for detailed information on the View
application.

Viewing documents is useful to verify that you have sclected the document you
want before you check it out.

Unlock

To Unlock a document from the Integrated Desktop, select the document(s) from
the document table and right mouse click. Then choose Unlock from the pop-up
menu,
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About Unlock

If you have suffered a network failure or system malfunction while you were
using documents you may find that those documents are still marked as IN USE.
In such instances, you can use the Unlock feature to tell the system to consider
the document ‘not-in-use’. This allows you or others to checkout the document.

Implications of Unlocking

Any copy of a document that exists locally will be ‘orphaned’ from the network
version after an Unlock is complete. You can only put the local document into
iManagc as a new document. Thercfore, you should only use the Unlock option
to free up documents that appear to be in use or checked out, but are erroneously
marked as such duc to a network or system failure,

Note: You can only unlock documents that are currently marked as IN USE by
you. You cannot unlock documents in usc¢ by other users.

Remove from folder

The Remove from folder menu option removes selected document(s) from a
particular folder. To delete a document from a folder, highlight the document(s)
to be deleted and right-mousc click. Then choosc Remove from folder from
the pop-up menu,

Note: The Remove from folder menu option docs NOT remove a document
from the network or a particular database, Removing a2 document from the net-
work or database requircs a Purge command. Not everyone who has Remove
from folder menu option permissions will have Purge permissions. Contact
your System Administrator for more information.

Purge
To purge 2 document is to remove it entirely from the database.
You purge a document {rom the database by highlighting the desired document in
the Document Grid and selecting Purge from the pop-up menu. Only the author
or operator of a document are allowed to purge a document, This option may also
be disabled for some users.
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Other Applications

Integration with CompareRite, DocuComp, FullAuthority,
and CiteRite

hQ‘ocu'menlj

Open T CulkD
Edit Profile... CthE
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QuickView Cirl+Q
View

Versions Ctrl+S
History Curl+H
Related Docurments Chrl+T

Copy ’
Check Out
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Export
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‘; Send >

Unlzek

| Applications | » IR D
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DocuComp

- Excel 2000

i Word 2000

! PowerPoint 2000

“y
Hermnve hom folder
i Puge

The iManage DeskSite program includes a dircct interface to the following docu-
ment utilities: CompareRite, DocuComp, FullAuthority, and CitcRite. Compare-
Ritc and DocuComp allow you to compare versions of documents with cach
other and to produce a report of variations. FullAuthority and CiteRite are cita-
tion utilitics that allow you to analyzc the citations that appcear in a document,
Access to these utilities is provided in iManage DeskSite by sclecting Applica-
tions from the Document menu, then selecting the appropriate application.

Uscrs must have a path established to the dircctorics for these utilitics. Each
iManage database automatically provides entries in the application table for each
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of these document utilities.

E-mail Integration

iManage DeskSite is integrated with electronic-mail products through the MAPI
interface standard, E-mail systems supported include:

*  Network GroupWise
*  Microsoft Mail

*  Microsoft Qutlook

*  Lotus cc:Mail

*  Lotus Notes

« DaVinci

About E-mail Integration

The iManage DeskSite program includes a user interface where you can select
documents and mail them through electronic mail,

Using standard drag-and-drop techniques, you can select documents that need to
be mailed from the iManage Desktop window’s Document Grid. Onee you have
sclected the documents, iManage DeskSite can automatically invoke the e-mail-
send mechanism. iManage DeskSite uses the MAPI standard to display Mail To
windows appropriate to the e-mail system present. When sent via ¢-mail, docu-
ment profiles have the extension TXT while document filenames have the appli-
cation’s cxtension—DOC for Word files, WRI for Writc filcs, ctc,
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Figure 5.10: Documents sclected for emailing appear as attachments in your
email application. This screen shot shows how a document appears in Microsoft

Qutlook,
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Additional Integrated Functions

Microsoft Word 97 and 2000

Additional integrated functions arc available in selected applications. The fol-
lowing additional intcgrated functions arc available in Microsoft Word 97 and
2000. Your system administrator can disable or enable some of these options
sclectively.

iManage Mail Merge

When you sclect iManage Mail Merge from the Tools menu, you can perform
a mail merge using documents {rom an iManage database as your master docu-
ment and data source document. To perform an iManage Mail Merge, sclect
iManage Mail Merge from the Tools menu, identify a master document and
data source document, then perform the mail merge. Links to the data source doc-
ument arc removed when you close the master document.

Compare iManage Documents

When the Compare iManage Documents menu option is enabled by your system
administrator, you can compare the currently open document against a document
in an iManage database by selecting Tools, then Track Changes, then Com-
pare iManage Documents, If this menu option docs not appcar, then this
option has not been enabled by you iManage Administrator.

iManage Footer

When you select the iManage Footer option from the View menu, the follow-
ing information will be inserted in the footer of the currently open document:

Document Name : Document Number — Version Number

If the document name field is empty, only the Document Number and Version
Number will be displayed. Other footer information, such as author name, page
number, filc path information, ctc., can be inserted automatically using built-in
options in Microsoft Word,
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IManage DeskSite
Advance Functions

-,

Overview

This chapter describes some advanced functions available in the iManage
DeskSite program.

+  Using CompareRite and DocuComp
*  Using FullAuthority and CitcRite
»  Sectting display options

CompareRite, DocuComp, Full Authority and CiteRite are not provided with
iManage DeskSite.

Other advanced features, such as portable mode and document echoing, are
described in Chapter 7 and Chapter 8 of this manual.

Using CompareRite and DocuComp

CompareRite and DocuComp are applications that enable you to compare ver-
sions of documents and to produce comparison reports automatically. For the
CompareRite and DocuComp menu options available in iManage DeskSite to
work properly, these applications must be integrated correctly with iManage
DeskSite.

To compare documents using CompareRite or DocuComp:

1. Highlight the two versions of the document that you want to compare in the
document grid.
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Note: To comparc versions of the same document you must show all versions of
the document. See “Defaults Tab™ on page 155 for details,

2. Sclect Applications from the Document menu,

3. Seclect CompareRite or DocuComp from the submenu that appears. The
CompareRite or DocuComp dialog box appears. The version of the docu-
ment shown first in the document grid is listed as the original document. You
can sort the grid by version number by clicking the column heading.

Compare Documents using DocuComp x

— Status —
Ready E_
Original Document Reavised Document
Database: [HR || Database: |HR R
Doc: |2727 | B Doc: Izz |
Ver; m Ver: [2——:]

Compare Information

Compare Doc Name:
|C:\DDCUME"’1 \bowerALOCALS~1\Temp\Result of comparis

* Dpen ' View

& Import

Compare Close

Figure 6.1: CompareRite dialog box

4. The application saves the comparison results to the file named in the Com-
pare Doc Name ficld. Enter a filename in this field.

5. Select how you want to handle the resulling comparison document.

- Select the Open button to the results document.

—  Select the View button to view the comparison results with the iManage
View program,

- Select the Import button to import the comparison results document
automatically into iManage DeskSite.
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6. Click Compare to perform the comparison,

Using FullAuthority or CiteRite

FullAuthority and CiteRite are sofiware applications provided by Lexis-Nexis
that cnable you to analyze the citations in a document. For the FullAuthority and
CitcRite menu options in iManage DeskSite to work properly, these applications
must be integrated correctly with iManage DeskSite.

To analyze citations in a document using FullAuthority or CiteRite:

1. Highlight a document in the document grid.
2. Select Applications from the Document menu,

3. Sclcct FullAuthority or CiteRite from the submenu that appears, The Full-
Authority or CiteRite dialog box appears with the highlighted document
listed in the dialog box.

4, Inthe Output Doc Name field, enter a filename that will be used to store the
table of authorities or citation report that will be produced by FullAuthority
or CitcRite,

—  Sclect the Open radio button to open the output file automatically.

—  Select the View radio button to view the output file in the iManage
Viewer

—  Seclect Import to add the output file to an iManage library.

5. Click Run to run FullAuthority or CiteRite analysis on the selected docu-
ment,
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; FullAuthority E3

! — Status
: Ready

Document Informaticn

Database  imanl
Dac 1000091 Ver 1

Description  atlanta_54_1

Output Document Information

Output Doc Name

C:\TEMP‘\TahIe of authorities for Doc 1000091 Ver 1.D0OC \

{* Open " View C Impoit
' Eun ;Io:sﬁ |

Figure 6.2: FullAuthority dialog box
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Configuration Options

iManage DeskSite allows you to customize the way information is displayed. To
access the Display Options dialog, select Options from the Options menu, The
Configure dialog is displayed in three tabs, Select Profile Fields, Defaults, and
Configure.

Select Profile Fields Tab ﬂ
The Select Profile Fields tab allows you to customize which profile fields dis-

play in the Document Grid and the Document Profile tab in the Documcnt
Results Frame,
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154

Configure

Select Profile Fields | Defauits | Configure |

Avallable Profile Fields: Display Column Fields:
Archived - Add > Database ‘
Author '_ Description ;
Author Description ¢ Bemmove | |Doe. Num ;
Checked Out Version 1
Class Author :
Class Description Class
Comments Edit Date
Create Date Fila Size
Custam1
Custom1 Description
Custom10
Custom10 Description
Custom1]

Eustom;l% Deascription Profile Fields:
ustom T
Custom12 Description Add > gg:cﬁﬁﬁn
Eﬂztgm 3 <- Remove \]{':f?gon
Custom15 P
Class
Custom1b Custom]
gustom;l ; Custom?2
ustomn
Custom1S Comments
Customz
Custom?2 Description
EZustom?l:J .ﬂ
Drag for Order
1] Cancel Help

Figure 6.3: Configure dialog, Select Profile Fields tab

To customize the Document Grid

The Display Column Fields list contains those fields that are already selected to

be included in the Document Grid (upper right side of the iManage DeskSite

Desktop). The column fields appear in the Document Grid in the same order in
which they appear in this list.

1.

To add profile fields to this list, select the desired field(s) from the Available

Profile Fields list and click Add.

To remove a profile field from the Document Grid, select the fields in the
Display Column Fields list and click Remove.
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3. Dragand drop the selected fields into the desired order.

To Customize the Document Profiles tab of the Document Results Frame

The Profile Fields list contains those fields that appcar in the Document Profiles
tab of the Document Results frame in the lower-right side of iManage DeskSite
Desktop. These fields appear in the same order in which they appear in the list.

1. To add profile fields to the Profile Fields list, select the desired field(s) from
the Available Profile Ficlds list and click Add.

2. To remove profile ficlds from the profile list, scleet the ficlds in the Display
Column Fields list and click Remove.

3. Drag and drop the selected fields into the desired order.

Defaults Tab

A number of different system settings are completed in the Default tab of the
Display Options dialog,
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Configure [ X |

Select Profle Fields  Defauits | Configure |

Search

Change seaich result options.
@ Maximum number of documents in Search Window:
ol

i ’, Document Version

* LatestVersionOnly ¢ AllVersions

Portable

‘ T Change portable options.
| @ Portable Drive: Ic ‘vl

Portable Path:  NRPORTBL

Echo

. Change echo options.
: Echo Drive: |C "I
; Echo Path: NRTECHO
Echo Size(MB)
" WorkSits

. Base Path:
|bttp://worksite.imanage.com

' 0K Cancel Help

'

Figure 6.4: Configure dialog, Defaults tab

Options of the Defaults tab:

* Inthe Maximum Number of Documents in Search Window fleld, enter
the maximum number of documents that should appear in the Document
Grid as the result of a search. The default value is 500,

* In the Document Version box, select either All Versions or Latest Version
Only.

Note: If you select Latest Version Only, you can still locate all the versions of a
document in the library by highlighting the document in the grid, then clicking
the Document Versions tab.
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In the Change Portable Options box, you can change the drive designation
of your Portable directory. The Portable Path is hard-coded to NRPORTBL.

In the Change Echo Options box, you can change the drive destgnation of
your echo directory and the size, in megabytes, of the Echo Directory. The
Echo path is hard-coded to NRTECHO. You can also change the size of your
Echo Directory by clicking the up or down arrows next to the Echo Size
(MB) ficld.

In the WorkSite box, you can enter the URL for accessing imanage Work-
Site in the Base Path field. iManage DeskSile uses this information when
you enter the commands Send Document URL Link or Send Folder URL
Link from Send on the Document menu.
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Configure Tab

Configure

Select Profile Fields | Defaults Conlfigure |

Timeout [seconds): | z’

€ Document Options ’ -
D Use forms and captions from preferted database.
D Check for checked-out documents on startup/exit,
Add implicit widcard characters to description searches.
[_]Delste local files after impart.
Fiter COMPARE and OCR classes out.
Check for modified echo documents on startup/exit.
D Check for orphaned dacuments on startup/exit

© Other Options
Verily before exiting the iManage infoRite. :
D Check for Microsoft Word before esiting iManage infoRits. __
|:| Choose the Connection Mode when starting. -

DAlways sort worklist by my access time. -
| LI'J

II |Cl-m...'| 1imelilint mmmaeabalis Far mamih dabakbanas
4

Purge termp documents if older than ID j Days

Default Command: I Open 7 .:l

0K Cancel | Help

Figure 6.5: Advanced Options dialog, Defaults tab

Timeout Option

Use the Timeout option to determine how long the iManage DeskSite client
wails before timing out. The default value is 30. You may need to increase this
value when connection times are slow or when downloading large files, for
example, over a WAN conncction,
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Document Options

¢ When Use Forms and Captions from preferred database is checked, the
iManage DeskSite client downloads the Forms and Captions stored on the
user’s Preferred Database as you need them and applies these forms and cap-
tions to other databases. When this option is not checked, Forms and Cap-
tions ar¢ downloaded from each individual database as you need them,

*  When Check for Checked Out Documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately after login
whenever it detects altered checked out portable documents on your hard
drive.

*  When Add implicit wildcard characters to description searches is
checked, iManage automatically inserts an asterisk at the beginning and end
of the search string in the description field when performing a profile scarch.

*  When Delete local files after import is checked, iManage removes docu-
ments from your local drive after you import them to iManage DeskSite,

*  When Filter COMPARE and OCR classes out is checked, iManage
DeskSite excludes all documents with the COMPARE and OCR (optical
character recognition) document classes. If you want to include documents
created with document comparison or OCR software, make sure this box is
not checked.

*  When Check for modified echo documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately afier login
whenever it detects altered echo documents on your hard drive.

*  When Check for orphaned documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately after login
whenever it detects orphaned documents on your hard drive, See “Orphan
Documents” on page 193 for more information about orphaned documents.

Other Options

*  When Verify before exiting iManage DeskSite is checked, you get a mes-
sage asking if you are sure you want to close iManage when you click the
exit button or sclect Exit from the File menu.

*  When Check for Microsoft Word before exiting iManage DeskSite is
checked, iManage DeskSite determines if the Microsoft Word application is
open, If so, you receive a warning message asking if you want to closc iMan-
age DeskSite even though Word is still running.

*  When Choose connection mode when starting is checked, you have the
option of connecting to the scrver, working in Portable mode, or logging in
manually.
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f you warit to connect to the server please choose the
Cornect option. If the workstation is not connected on the
network, please choose Lhe Portable option.

Connect Portable Manual Login Help

Figure 6.6; Server Connection dialog

-~ If you choose Connect, iManage DeskSite opens and connects to the
servers that are registered and sclected for auto login.

— Ifyou choose Portable, iManage Portable opens.
— Ifyou choose Manual Login, the Register Servers dialog opens so you

can log into the servers you choose. Sec *Connecting to WorkSite Mid-
dle Tier Servers™ on page 44,
*  When Always sort worklist by my access time is checked, the work list on
the document grid sorts in the order in which the current user accessed the
documents, This order may differ from the actual edit time of some docu-

ments since the edit time of a document changes if another user accesscs the
file.

*  When Show Worklist separately for each database is checked, the tree
frame shows both a consolidated worklist that includes all databases and an
individual worklist for each database that shows the documents that you
worked on most recently from just that database.

»  When Show overflow message if search returns have more entries is
checked, you receive an indicator in the status bar showing that your search
request received more matches than in the search results list.

500 Items

Figure 6.7: Overflow indicator

Purge temp documents if older than __ Days

When you perform Print, View and Quick View operations in iManage DeskSite,
the system creates temporary files on your computer. This sctting lets you deter-
mine how long to retain these files. When you close iManage DeskSite, these
files are permanently deleted after the number of days you specify here.
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Default Command

Select from the list of commands in the Default Command drop-down menu to

decide what a double-click should signify in the Document Grid. See the table
below for details. Click OK when you have finished setting defaults,

Table 6.1: Options for double-clicking in the grid

If you select... | When you double-click on a document in the
grid...

Open iManage DeskSite opens the document in its associated
application.

Edit Profile You can view or edit profile information for the document.

Print iManage DeskSite prints the document.

Quickview The document appears in the Quickview frame.

View iManage DeskSite opens the document in the View appli-
cation,

Versions The document version tab displays a list of all the versions
of the document.

History Document activity history for the document is displayed

Related The related document tab displays a list of all the docu-

Documents ment related to the selected document.

Checkout The Checkout dialog box appears with the document listed
as the document to be checked out.

Checkin The Checkin dialog box appears with the document listed
as the document to be checked in.

Checkedout iManage DeskSite opens the Checkedout Info message

Info box.

Export iManage DeskSite opens the Export dialog box.

Unlock iManage DeskSite unlocks the document,

Remove from iManage DeskSite removes the document from the current

Folder folder. The document is still in the library,

Purge iManage DeskSite deletes the document from the library.
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Overview

iManage View lets you view documents without the need to launch their native
applications. You can view multiple documents and print all or portions of the
documents being viewed.

To view documents from the iManage DeskSite program, select one or more doc-
uments you want to view in the document grid, then scleet View from the Docu-
ment menu. A submenu appears; select View again from the submenu, If
iManage View is not running, iManage DeskSite launches iManage View, then
displays the documents in read-only format. You can also display documents in
iManage View by highlighting multiple documents, then clicking on the View
button in the toolbar,

To view documents from the iManage Integrated Desktop, select documents in
the documents list and right-mouse-click. Then choose View from the pop-up
menu. The iManage View program will launch with the documents displayed in a
view window.

You can also launch the iManage View application manually.
iManage View allows you to:

*  View documents in rcad-only format even when they are checked out or in
use.

»  Scarch the full text of documents currently displayed in the viewer.

»  Copy portions of documents for pasting into other applications
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*  Print documents

File types supported by iManage View include all major word-processing,
spreadsheet, and graphics file formats.

Note: When you view documents using iManage View, those documents arc not
locked or checked out of the database. Instead, the iManage View program makes
a temporary copy of the document, which is displayed in read-only format.

Document Types Supported

The major word processing, spreadsheet, and graphic formats supported by
iManage View arc listcd below:

Word Processing Formats
Word for Windows 1.0, 2.0, 6.0/7.0 and 2000
WordPerfect for Windows or DOS 5.0, 5,1/5.2, 6.0 and 7.0
Ami Pro 3.0
Word Pro
Windows Wrile
Word for DOS 5.x and 6.0
Professional Write 2.0
DisplayWritc
MultiMate
OfficeWriter
Wang PC
FramcMaker Interchange Format (MIF) (text only)
StarOffice Writer 5.2 (text only)
ANSI Text

Spreadsheet Formats
Excel 3.0,4.0, 5.0 and 7.0
Lotus 1-2-3 for Windows or DOS 3.x and 4.x

QuattroPro for Windows
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Graphic Formats
Windows Bitmap
Windows Metafile
WordPerfect Graphic 1.0, 2.0
Ami Draw
Tagged Image File Format TIFF
Micrografx DRW
CompuServe GIF
Paintbrush PCX

Miscellaneous Formats
Adobe Acrobat PDF (text only)
Website META Language (WML)

Presentation Formats

Microsoft PowerPoint
iManage View Window

If you launch iManage View manually, the iManage View window initially con-
tains no documents, If launched automatically—such as when you sclect the
View option in iManage DeskSite—this window contains read-only copies of the
documents that you selected. Below is an example of the iManage View window
with three local documents displayed in tile format,
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Figure 7.1: iManage View with documents displayed in cascade format

Tile and Cascade Formats

You can display documents in cascade or tiled format. Figurc 7.1 shows an exam-
ple of the tiled format. Following is an example of the same iManage View win-

dow with the three documents displayed in cascade format. You can also display

other documents in the window as minimized icons.
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Figure 7.2: iManage View with documents displayed in cascade format

Viewing Local Files

You can usc the iManage View program to view documenis on an iManage data-
base and/or documents that are stored locally on your hard drive or another net-
work drive.

To view local documents:
1. Launch the iManage View program,

2. Sclect Local Open from the File menu, The Select Local File to View dia-
log box opens.
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Figure 7.3: Select Local File to View dialog box

3. Use standard Windows techniques to locate and select a local file to view in
the iManage View program, then click Open to display the file in the view
progrant.

Searching the Full Text of Documents

. Search String: Ianw!eq__qe_ Conferencd ‘_ﬂ
" Onions ST

: Brigin

- | TI7 Match Case " From Cuisor

- | W Find Backward (¥ Entire Scope
! 0K - Cancel

Figure 7.4: You can usc the Find dialog box to search the full text of any docu-
ments displayed in iManage View
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Note: The Find Text dialog box opcrates only on the active document displaycd
in iManage View. That document must be a word-processing document or
sprcadshcet. Textual scarches cannot be performed on other document types.

1. Select Find from the Search menu.

2. Enter the text for which you want to scarch in the Search String field.

3. Ifyou click the down arrow :J, you can select from a list of search strings
that you entered previously.

4, Click OK to start scarching,

Search Options

»  The Match Case option specifies whether the search should be case-sensi-
tive. If you do not check Match Case, all instances of your search string will
be found regardless of whether they appear in upper or lower case.

*  The Origin options specify where the search should start. If From Cursor is
sclected, the scarch will begin at the current position of the cursor in the
active document. If Entire Scope is selected, the search will begin at the
start of the document and proceed forward, or at the end of the document and
proceed backward, depending on which direction is selected,

» The Find Backwards option specifies the direction the scarch should pro-
ceed.

Printing Documents

You can print all or portions of documents that arc displayed in iManage View by

clicking on the Print icon or by selecting Print from the File menu. You may
also selcct Copy from the pop-up menu on a right-mouse-click, When you select
Print, a standard Print dialog box appears. The Print option operates on only the
currently active document in the iManage View window.

Setting Print Options

You can set printer options from the iManage View window by sclecting Printer
Setup from the File pulldown menu, A standard Print Setup dialog box appears.
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Copying Documents

You can copy all or portions of documents for pasting into other applications by
highlighting the portion of the document that you want to copy, then clicking the

Copy icon or sclecting Copy from the Edit menu, You may also sclect Copy
from the pop-up menu on a right-mouse-click.

Setting Display Options

You can display documents in iManage View in a number of different formats.
Different documents can be displayed in diflerent formats at the same time.

Word-Processing Documents

You can display word-processing documents in Draft, Normal, or Preview
mode:

*  Draft mode displays the document using the default font without the origi-
nal formatting. Text wraps as necessary to display all text in the view win-
dow.

*  Normal mode displays the document using the specified fonts in the docu-
ments and using the specified formatting. Text wraps inside the view win-
dow to display all text in the document.

*  Preview modc displays the document using the specified fonts and specificd
formatting, Text docs not wrap in the view window: Preview mode shows
how the document would look when printed.

Bitmap Files

You can adjust the size of bitmap files that are displayed in the iManage View
program and/or rotatc these images in the display by increments of 90°, To
change the size or rotation of a bitmap image, sclect the window in which the
image is displayed, then select Bitmap from the Options menu. A submenu of
display options appears, Select the size and/or rotation desired.

Vector Graphics

You can adjust the size of vector graphics files that are displayed in the iManage
View program by sclecting Vector from the Options menu. A submenu of dis-
play options will be displayed. Select the option desired.
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Setting Default Display Options

You can sclect a default font that will be used to display ANSI text and select a
file format to use to view files of unknown type. To set these options, select
Options, Document, then Font. The Display Options dialog box will be dis-
played. The Display Options dialog box lets you specify iManage View's default
fonts and file formats,

Display Options

" —Default font T

Avrial - 10 point - Normal

Cancel
Change —_——

Help

I ~View unknown files as
' Text

" Hexadecimal

More...

" Do nhot view

— Character sat for taxt files

" Windows [ANS) 1252) " Central European [Latin 2)
I . ASCII (7 bit) " Chinese (Big5)

. DOS (Latin 1) " Chinese (GB)

" Uricode " Korean (Hangul)

" Macintosh ¢ Cyrillic (ANS] 1251)

(" Japarese [Shift)IS) " Cyrillic [KOIS-R)

(" Japanese (EUC)

Figure 7.5: Display Options dialog box

* To change the default font of ANSI files, click the Change button. A stan-
dard Windows Fonts dialog box appears, allowing you to specify the font.

*  To set the default display mode for documents of unknown file type, sclect
the corresponding display option,

*  Todisplay additional options, click More. The More Display Options dialog
box appears.
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More Display Options

172

You can also set display options that specify how to display database tables and
sprcadsheet information. If you want to show gridlines for either of these dis-
plays, check the Show gridlines options.

The More Display Options dialog box is displayed by clicking on the More but-

ton in the Display Options dialog box.

Note: The options included for specifying display options for archived docu-

ments are not implemented.

More Display Options

— Spreadsheet
V¥ Show gridlines

~Database

- | ¥, Show gridines

~ Archive
{* Don't sort files

" Sort files by name

" Sort files by size

| € Sortfiles by date & time
i Sort Order

| ¥ Ascending

i " Descending

Cancel

Help

Figure 7.6: More Display Options dialog box
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1Manage Portable

Overview

A portable mode of operation allows you take the iManage DeskSite document
management system on the road with you and helps you synchronize your work
with the network when you get back to the office. The process works like this:

1. A user checks out the desired iManage DeskSite documents, individually or

CIt massc.

2. Once disconnected from the network, you can access portable documents

through the iManage Portable application or through the standard commands

(open, save, cte.) of an intcgrated application,

3. When the user re-attaches to an iManage DeskSite database, you can auto-
matically check in the checked out documents and synchronize them with
iManage DeskSitc.

From Portable mode while disconnected from the network you can perform

the following standard iManage functions:

*  Import documents and assign a new document profile
*  View and Quickview documents

»  Save edited docurments as new documents

*  Savc cdited documents as the same document, thereby replacing the network

version when synchronized with iManage DeskSite
» Edit and View document profilcs

*  Send documents as attachments to emails
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What you cannot do in Portable Mode:

*  Save document as a new version of the same document
+  Edit document sccurity

Note: Echo documents are also accessed through portable mode. See Chapter 9;

Using Echo Documents.
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Setup Procedures

Portable-mode operation does not require extraordinary amounts of memory or
resources on the portable PC and does not require a separate stand-alone SQL
database on the portable PC.

To access portable documents effectively, you need to set up your PC in the
following manner:

+  The PC must be registered for portable-mode operation.

*  The PC should be able to run from a local copy of the Windows operating
system.

* Local stand-alone versions of the application programs associated with the
portable documents should be available on the PC,

Application Setup in iManage Portable

The local application table contains information that is used by iManage Portable
to launch applications and to associate particular document types with appropri-
ate applications, It is recommended that you do NOT edit the local copy of the
application table UNLESS you understand the way applications are integrated
with iManage. Information on how the application table is created and main-
tained and how iManage is integrated with other applications is provided in the
iManage DeskSite Administrative Reference Manual,

Reasons why you might need to change the local copy of the application table
include;

*  The path to an application changes
*  You want to associate a document type with a different application

*  You want to integrate an application that is not listed in the application table
on the database

To Add or Edit an entry to the local application table:

1. Click the App Setup icon or sclect Local Applications from the
Options menu.
2. Click the Add or Edit button in the Application Setup Information dialog.

3. Complete the ficlds in the App Setup Entry dialog, Click OK when finished.
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Note: iManage Portable’s on-line help contains a detailed cxplanation of cach
field appearing in the App Setup Entry dialog.

Checking Out Portable Documents from iManage
DeskSite

iManage DeskSite provides you with the ability to check out multiple documents
in a single operation for portable-mode access. The checked-out documents are
marked as in use in iManage DeskSite.

The checkout process copics the documents to the portable-document location on
the local PC. This location is defined during portable-mode registration.

The profile information of the checked-out documents is also copied to the local
portable-document location. iManage Portable uses the local profile information
to find and access portable documents. You can change the profile information in
portable mode.

To checkout a document in portable mode:

1. Select a document by clicking on it in the iManage Desktop window’s Docu-
ment List, The document row becomes highlighted.

2. Click the Checkout toolbar button. The Checkout dialog box appears.
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. r~Document information
Database:  Finance
bl Number: 414 Version: 1

Description: Project Plan

i —Options
[V Portable Checkout

Destination Path; l ‘ J

— Details
. | DueDate: | 6/21/01 Ll

-
Comments: '

0K " Cancel | Help

Figure 8.1: Checkout dialog box

3. Place a checkmark in the Portable Checkout ficld. The Destination Path
field becomes deactivated because all portable documents are stored in the
same directory.

4, Note your reason for checking out the document in the Comments field,
specify the due date, and click OK. The iManage Desktop window reap-
pears.

Working with Portable Documents from within Integrated
Applications

You can open documents that are checked out in portable mode from within inte-
grated applications,

Steps:

1. Launch iManage Portable if it is not already running,
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2. Launch the integrated application

3. Select Open from the File menu in the integrated application. The Inte-
grated Portable Desktop dialog box appears.

v e . o ) M'L?_IP_(J

E-(8) Portable Databases

-3 BusDev
~[Z Carporate

-3 Couespondence

[ dbase?0

3 Dev

~[F Eugene

& Finance
@ HR
@ HRD

-3 iDocs

& imant
iman1bb

-3 iman2
-3 iman3

(@ iManage

{3 Legal
- [ Maiketing

- newS0db
{2 PRIMERA

R Prmiants

1y

ety

wl|

Database Edit Date
A Fi 1 . 6/21/01 9:32:20
v FFin.. RevisedD... 413 1 MLIND.. DOC  6/21/01 9:31.50
V' FiFin.. Markeling.. 412 1 MUND.. DOC  6/21/01 3:31:14
VF]Fin.. Pioposals 411 1 MUND.. DOC  6/21/01 9:30.44
Database: | mance - Current View: IChackedaul '~'| ShowEelds
" Number: I | Version: v Open I |

Fiter Corditions:
[‘Type

I ‘vl Modified Om; |Any Time "I

Cancel |

|4 Document(s] Found.,

Figure 8.2: Integrated Portable Desktop dialog box

Working with Portable Documents from within iManage
Portable

178

You may access documents dircctly from the iManage Portable application,

Read-only documents are indicated in the Portable directory by a locked icon®
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IY]iMANAGE Portable MG

file View Document Oplions Help
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IEcho documents ‘_'_| |
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Figure 8.3: iManage Portable Application Desktop window

To Open Portable Documents

1. Launch iManage Portable and select Checkedout Documents (rom the
drop down list. The Checkedout Documents list appears in the panel.

2. Sclect the desired document and click the Open icon |Z7] or just double-click
on the desired document. The document opens in the local application that is
associated with the document’s type.

Note: The Portable program looks for documents that were checked out by the
same user whose ID was used to log into Windows. If you checked out docu-
ments for portable use using a user ID other than the one you used to log into
Windows, the Portable program will not be able to find those documents, If that
happens, log out of Windows and log back in using the user ID that you used to
log into the WorkSite Middle Tier Server when you checked out those portable
documents.

To View Portable Documents

There arc two options to view portable documents,
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To view a portable document using the iManage View program:

iManage View is a sophisticated viewer program allowing you to view multiple
documents at the same time and in different formats. To view a document this

way, highlight the desired document(s) and click the View icon or sclect
View from either the Document menu or the right-click pop-up menu on the
selected document.

To view a portable document using Quickview:

Quickview is an easy way to view a document without leaving the Portable appli-
cation. To view a document this way, highlight the desired document and click

the Quickview icon @ or select Quickview from either the Document menu
or the right-click pop-up menu on the selected document.

Editing/Viewing Portable Document Profiles

Portable document profile information can be accessed and edited by highlight-

ing a document in the document list and clicking the Edit Profile icon or by
selecting Edit Profile from either the Document menu or the right-click pop
up menu of the highlighted document. Profile information can then be viewed
and updated. Updated profile information is verified when the portable docu-
ments are checked back into iManage DeskSite.

Printing Portable Documents

You can print documents directly from iManage Portable by clicking on the Print

icon @ or by sclecting Print from either the Document menu or the right-
click pop-up menu on the highlighted document. This will automatically launch
the document in its associated application and perform a print command,

Note: This portable print command does not launch a Print Options dialog box
before printing. See the next section about Print and Page sctup options.

Print and Page Setup Options

Sclect Printer Setup from the File menu to launch the Printer Setup dialog.
This dialog provides choices of printers, page types and Portrait/Landscape ori-
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entation formats.
E-mailing Portable Documents

From the iManage Portable application you can create a new ¢-mail message
with sclected documents as attachments.

3. Selectthe document or documents you wish to attach and click the Send icon

@l or sclect Send from either the Document menu or the right-click pop-
up menu of the highlighted document. The Mail Documents window opens,

Mail Documents '
H

Database | Num | Ver | Description
IDOCS_ . .. . 2609 2  50UMChapter5

Eemové |

e COMETTY  Close

Figure 8.4: Mail Documents window

4. Ifthis is the document you want to send, click Mail. A new e-mail launches
automatically from your e-mail application with the selected documents as
attachments.

5. You canremove any document from the list by highlighting the document
and clicking Remove.

Import Documents to iManage Portable

If you have created a brand new document while away from the network you can
integrate it with iManage DeskSite when you return to connectivity. Do this with
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the Import feature.

Steps to Import:

1. Launch iManage Portable,

2. Click the Import icon Ce| or select Import from the File menu.

Find File To Import

tlockin [ iMansge -] & e

\ ] Verity ] Crtrls.do {»] Debmp.dil

| |2 admin.pot %] Code. il [*] Dehex.dl

" [»] Bwee32.dl 3 DbAdmin.exa %] Demet.dl

' [FCload.doc )] DbAdmin.GID ] Dess.dl
mclload.eue @Dbadmin.h!p hd Detree.dll

" |#] Cromap000.bin ) bBadmin.log [*] Dewp.dt

! File name: .V - Open

 Flesofype: [AlFies= ] Cancel

Figure 8.5: Find File To Import dialog box

3. Use the Find File To Import dialog to navigate to the document you want to
import. When highlighted, click Open.

4. The New Document Profile dialog launches. Complete the document’s pro-
file and click OK when complete.

The document then appears in the document list of iManage Portable. It is ready
to be checked in with all the other documents when you re-connect 1o the net-
work.

Check-in Portable Documents

When you have been working in portable mode and you attach to an iManage
DeskSite database, you can check in the checked out documents and synchronize
them with iManage DeskSite. The check-in process verifies the profiles of the
portable documents against the profile-entry tables. If errors are detected, you are
prompted to enter correct information.
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To check-in a portable document:

1. Launch iManage DeskSite and click Checkin on the toolbar. The Checkin
Documents dialog box appears.

2. Select the documents to be checked in using standard Windows techniques.
3. Click thc Checkin button. The Checkin Options window appears.

4. Select either the Replace Original or New Version option. To apply the
sclected option to the entire group of documents that you're checking in,
sclect Apply to AlL

5. Click OK to cheek in the documents and return to the Checkin Documents
dialog box.,
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- Using Echo
Documents

.,
.,

Overview

All computer networks fail at some point. iManage has created a safeguard for
such an event. It's called document echoing,

Every time you close an iManage document, iManage DeskSite saves a duplicate
copy to your hard disk. This is done to ensure that you can still access and per-
form functions to your important and recently used files, cven when the network
fails,

If you make revisions to these documents offline, iManage DeskSite provides a
synchronize function to integrate revised echo documents back into the network,
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Setup

Enabling Document Echoing

iManage DeskSite echoes documents on your PC only if Document Echoing is
cnabled.

Your iManage DeskSite administrator can disable document echoing globally or
for any given class of documents. If your PC is registered for portable mode but

iManage DeskSite is not echoing documents to your hard drive, contact your sys-
tem administrator for more information.

If you are enabling document echoing as a safeguard against network failure, you
should also cnsure that your PC is ablc to run a local copy of the Windows oper-
ating system and local, stand-alone versions of the application programs associ-
ated with your echoed documents. In the casc of a network failure, networked
copies of Windows and of essential application programs are not available,

Even in the absence of the application programs associated with your echoed
documents, if you have a local copy of the Windows operating system on your
PC, you can view your echoed documents using iManage View.

Setting the Default Drive for Echo Documents

You can select the disk drive where iManage DeskSite saves echo documents.
Normally, the echo documents are stored on a disk drive on the user’s local PC.
While the disk drive for the ccho dircctory can be changed, the name of the dirce-
tory is always nrtecho.

1. Choosc Options from the Options menu to open the iManage Desktop
window’s Configure dialog.
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dConfigure

Select Profile Fields  Defaults | Configure |

Search

Change search result options.
i Mauimum number of documents in Search Window:
o

Document Version
’>F LatestVersionOnly € Al Versions

Portable
Change portable options.

iE G} Portable Drive: m

Portable Path:  NRPORTBL
: Change echo options.
@j Echo Drive: |C 'l

: Echo Path: NRTECHQO

EchoSize(MB) [35 =

WorkSite

. Base Path:
[nttp://woiksite.manage.com

OK Cancel Help

Figure 9.1: Display Options dialog where Echo defaults are set.

2. Specify the disk drive where iManage should stere your echoed documents
and the maximum size of the echo dircctory. If the total size of the echo
directory exceeds the specified limit, iManage DeskSite prompts you to

- purge the echo directory. For instructions on how to purge echoed files from
the ccho directory, sce “Purging Echo Documents” on page 196. You can
change the size of the echo directory, if you need to, by clicking the up or
down arrows in the Echo Size (MB) field.
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Using Echo Documents

You can access echo documents either through the iManage Portable application
or through an integrated application such as MS-Word, WordPerfect, etc.

Note: If you attempt to open a document that is currently in your Echo directory
because you worked on it previously and made changes to it that are not reflected
in the copy on the file server, iManage DeskSite will not let you open the docu-
ment. Since iManage DeskSite copies a document to your Echo directory when
you open it, this feature prevents you from overwriting changes that you made to
the document.

Access Echo Documents from an Integrated Application

Steps to open documents that are checked out in portable mode from within inte-
grated applications:

1. Launch iManage Portable if it is not already running.

2. Launch the integrated application.
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Figure 9.2: Integrated Portable Desktop

Access Echo Documents from the iManage Portable
Application

Launching iManage Portable allows you to perform a variety of functions with
echo documents. The main desktop screen looks like this:
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Figure 9.3: iManage Portable Desktop Window

Functions within iManage Portable

Because both Echo Documents and Portable documents are accessed through
same Portable application the document functions are identical. Chapter 8 con-
tains greater detail of the following document commands:

Open Echo Documents

Double-click on the desired document in the Echo Document List or highlight

the document and click the Open icon @ You then get a message that the doc-
ument may have been changed by another uscr, If this is the casc, you can check
in the document to iManage DeskSite only as a new document.

Your system administrator may have configured your machine to display echo
documents for all users on your machine,

190
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& You are opening an echo copy of the document *1018190_1", This
document may not 1eflect the latest changes made to the document in
iManage. After you edit it, you may be able to copy it back to iManage
only as a new version, Do you want to cortinue?

Yes Na Details »>

Figure 9.3: Echo document warning message

View Echo Documents:

Highlight the document(s) and click the View icon [54) This will launch iMan-
age View - a sophisticated viewer application. See Chapter 7 for morc informa-
tion.

Quickview Echo Documents

Highlight the desired document and click the Quickview icon . The document
will be displayed in the botlom right frame of the Portable Desktop Window.

Printing Echo Documents

Highlight the desired document(s) and click the Print icon . The document’s
associated application will launch and the document will be printed. Please note
that this portable print command will not launch a Print Options dialog box
before printing, See the next section about Print and Page setup options.

Printing a List of Echo Documents

To print a list of the documents currently displayed in the Document List of the
Portable Desktop sclect Print Preview from the File menu. This will launch the
list in the Print Preview dialog where you can execute a print command,

Sending Echo Documents

Highlight the desired document(s) and click the Send icon . A new e-mail
will launch automatically with the selected documents as attachments,
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Saving Echo Documents

After opening an echo document, you can save changes or revisions to it with the
Save command under the File menu in the application associated with that docu-
ment. Documents saved using the save command will be recognized in iManage
DeskSite as echo documents. If you use the Save As command to create a new
document from a revised echo document, however, the document will be identi-
fied as a ncw portable document in iManage DeskSitc.

Deleting Echo Documents

Highlight the desired document(s) and click the Delete icon . You can also
delcte Echo documents from the Checkin/Synchronize dialog box in iManage
DeskSite.

Editing and Saving Echo Documents

Aficr opening an ccho document, you can save changes or revisions to it with the
Save command under the File menu in the application associated with that doc-
ument. Documents saved using the save command are recognized in iManage
DeskSite as echo documents, If you use the Save As command to create a new
document from a revised echo document, however, the document is identified as
a new portable document in iManage DeskSite,

Synchronizing Echo Documents into the Network

If you edit and save an ccho document while offline, you will eventually want to
copy the document back to the network after network connections are restored.
iManage DeskSite provides an casy way to copy ccho documents that have been
revised and saved locally back to the network. This process of copying altered
ccho documents back to the network is referred to as synchronization.

When you start iManage DeskSite you will get a warning if you have echo docu- _
ments with changes that arc not reflected in the copy on the file scrver, This fea-
ture helps prevent you from overwriting changes that you made to the document.

Requirements for synchronization of a document

¢ Only the last user who edited a document through iManage DeskSite may
synchronize an echo document. Other users who attempt to do so receive a
warning message and are instructed to contact the particular user who last
cdited that document,
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*  Your echo copy of a document must be newer than the copy on the network.
iManage DeskSite does not allow you to synchronize an echo document

back to the network if the network copy of the document is-newer than your
ccho copy.

*  You must have write access to the network copy of the document. You can-
not synchronize a document il you have read-only access to the document.

You have the option of copying a document back as the original document,
importing it as a new version of the original document, or importing it as a new
document, If you are unable to use iManage DeskSite’s synchronization process
1o copy your updated echo document to the network, you can instead import the
ccho document as a new document or a new version of the same document.

To synchronize an echo document:

1. IniManage DeskSite open the Checkin/Synchronize Documents dialog by
sclecting Checkin/Synchronize from the Portable menu.

Checkin/Synchronize Documents 54§

Checkedout Documents  Echo Documents

Session Name; |PAH|5 _v_]
40 1 —|
aimdf070520011910... 321 1 6F Eind...
Project Plan 414 1 WORDY '
Finance Revised Documents 413 1 WDHD'!‘ Delete _|
Finance Marketing Options 412 1 WORD.|. o
! . Purge
4 I - SO - _‘._| .‘-‘ ‘_‘ ‘ | = ll
ltems: 5 I™ i Show only echo modified

"~ Close '

”l}.-ie]p ‘ |

Figure 9.4: Synchronize/Purge Echo Documents dialog box

2. Profile information for echoed documents appears in the display table, Use
the horizontal scroll bar to display more profile fields.
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*  Use the vertical scroll bar or Page Up and Page Down buttons to dis-
play all the echo documents,

*  Use the Find button to search for echoed document profiles if the list is
large.

*  Check Show only echo modified to display only the echo documents
that have been changed.

3. Use standard Windows techniques in addition to the Select All and Deselect
buttons to sclect documents for synchronization back into the iManage
DeskSite database.

4. Click Synch to begin the synchronization process. The Confirm Synchronize
dialog box opens.

Confirm Synchronize

— Dacument Information

=) Number; 1,018,306
Version; 1
Description:  iManage Travel Prolile
- Echo Document — Database Document
= Last edit date:  11/15/2000 '_‘ﬁ Last adit date:  11/15/2000
Last edit ime;  14:49.00 Last edit time;  13:22:44
File size: 4550 KB File size: 4650 KB
Last user BOWEN Lasl user; BOWEN
~ ~ Options

*' Replace Original

" New Version

" New Document

194

oK Cancel Skip Help

Figure 9.5: Confirm Synchronize dialog box

5. Verify the comparison between the Echo document and the Database docu-

ment. Choose whether you want to replace the original document, create a
new version of the document, or create an entirely new document. Not all of
these options are available in every circumstance.

* Ifthe document is checked out in the iManage library, you can return
the Echo document to the library only as a2 new document.
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* Ifthe document is not checked out in the iManage library and you were
the last user of the document, you can return the Echo document to the
library as a new version, a new document, or replace the origina! docu-
ment.

*  Ifthe document is not checked out in the iManage library and you were
rot the last user of the document, you can return the Echo document to
the library only as a new version of the document or as a new document,

6. Click OK to synchronize the document, Cancel to cancel the synchronize
operation for all documents you have highlighted, or Skip to cancel the syn-
chronize operation for the specified document only.

Icons in the Checkin/Synchronize Documents dialog box

Icons in the Checkin/Synchronize Documents dialog indicate the condition of the
documents displayed in the windows. The list explains what the icons mean:

[= — This icon appears in the document display area of Checkedout Docu-
ments tab. The document that it is associated with is a checkedout docu-
ment.

— This icon appcars in the document display arca of both the Checked-

out Documents and Echo documents tab, In the Checkedout Documents
tab, this icon indicates that an “orphan” document exists in the NrPortbl
dircctory. In the Echo Documents tab, this icon is uscd to indicate
unmodified echo documents that exist in the NrtEcho directory.

] — This icon appears in the document display area of Echo Documents

tab, This icon identifies echo documents that have been modified and
nced to be synchronized.

Orphan Documents

A user may have documents in his or her Portable or Echo directory which are
not checked-out by that user (Orphan documents). When the user starts working
in Portable mode, iManage DeskSite shows that the document is checked-out.
The uscr can modify the document in Portable mode, However, when the user
starts iManage DeskSite, he or she needs to know the local copy of the document
has modifications that are not in the iManage file server copy.

iManage DeskSite identifies documents in the user’s NRPortbl or NRTEcho
dircctory and determines if they are checked out by the user. If there arc docu-
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ments in the NRPortbl or NRTEcho directory that are NOT checked out by the
user, iManage DeskSite distinguishes those documents from documents checked
out by the user or created in Portable mode that need to be checked in.

You can then import the orphaned documents into iManage DeskSite as new doc-
uments,

Purging Echo Documents

1. IniManage DeskSite, open the Checkin/Synchronize dialog by selecting
Checkin/Synchronize from the Portable menu.

2. Click Purge. The Set Purge Criteria dialog box appears:

‘ Set Purge Criteria

Delete documents if older than " days

BK ” Cancel Help |

Figure 9.6: Set Purge Criteria dialog box

3. To delete all documents older a certain number of days, enter the maximum
age in days of ccho documents that you want to keep and click the OK but-
ton. All documents older than the specified number of days are deleted.

Note: The number of days sct in the Ser Purge Criteria dialog box is only for
this manual purge of the directory. Echo documents continug to accumulate
unless you purge the directory in this manner again. For instructions on how to
purge the echo directory automatically, see the iManage DeskSite User Reference
Manual.

Purging Echo Documents Automatically

You can set up your computer to automatically delete echo documents based on
age at startup of iManage Portable. To implement this feature:
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1.
2.
3.

Create a shortcut to Portbi32.exe

Right-click on the shortcut and select Properties.
In the Properties dialog that appears, click the Shortcut tab.
Shortcut to Portbl32.exe Properties KEd

General Shorteut | Securilyl

& E Shortcut to Porthl32.exe

Targettype:  Applization

Targst location, iManage

Target: "C:\Program Files\iManage\Porth!32 exe" -D20

¥ Bunin separtate memow spece T Pun as different user

Start in: I"C:'\F’rogram Files\iManage"

Shortcut key: INone

Rurn: |Norma| window _ o LI

Comment; I___ o

Find Target... | Changelcon...l

0K Cancel | Apply

Figure 9.7: Shortcut Properties dialog box

4,

In the Target field, enter the path to the portable executable file followed by -

D then the maximum age of echo documents in days,

Example: If iManage is installed in the default installation path, you might

enter the following in the Target field:
"C:\Program FilesliManage\Portbl32.exe" -D 20

Where 20 represents the maximum age of an echo document in days. Docu-

ments older than this specified number of days will be deleted.
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6. When you double click on this shortcut to run the Portable application, any

echo documents older than the specified maximum age are deleted.

Silent Mode

You can also use this command line feature in silent mode. Silent mode means
that when you double click on the shortcut, the Portable application only runs
long enough to delete any echo documents older than the specificd maximum
age, then exit. To implement this feature in silent mode, substitute -DS for -D.

Example: "C:\Program Files\iManagel\Portbl32.exe" -DS 20

This command line opens iManage Portable, purges echo documents older than

20 days from the echo directory, then exits from iManage Portable.

Shortcut to Portbl32.exe Properties E

General Shortcut | Securit_l,ll

@E Shortcut to Portbl32.exe

Targettype:  Application

Target location: iManage

T arget; "C:\Program Files\iManags\Partbl32 exe' -DS20

I Runin separate memony space | Run as different user

Start in: l"C: \Program Files\iManage"

Shortcut key: |N one

Run: [Nomalwindow ~—— —+]

Comment; l

Find Targst... I Change lcon... I

OK Cancel I Apply

Figure 9.8: Shortcut Properties silent mode dialog box

AUT0020198



Chapter 9: Using Echo Documents

Purging Documents for All Users

You can use this command line to purge echo documents for all users, not just the
current user. To do this, substitute -PS for -D or -DS.

Example: "C:\Program Files\iManage\Portbl32.exe" -PS20

This command line opens iManage Portable, purges echo documents older than
20 days from the ccho directory, then exits from iManage Portable.

Shortcut to Portbl32.exe Properties

General Shortcut | Security |

ﬁ Shortcut to Portbl32. exe

Targettype:  Application

Target location: iManage

Targel: "C:\Program Files\iM anage\Portbl32 exa" -PS20

¥ Buninseparste memow space T Run as different user

Start in: I"C:\Program Files\itanage"

Shartcut key: INone

Run: | Normal window _ ﬂ

Comment; I

' Find Target... Change Icon... |

0K Cancel Apply

Figure 9.9: Shortcut Properties silent mode dialog box to purge echo documents
for all users
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